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1. Úvodní informace

Blahopøejeme Vám, �e jste si vybrali ná� emulátor EPIC16A. Tento pøístroj jsme
koncipovali tak, aby Vám pøinesl maximální efektivitu práce pøi vývoji programù pro
neju�ívanìj�í mikrokontroléry Microchip PIC.

Unikátní konstrukce emulátoru nepou�ívá bì�ný emulaèní èip, ale moderní
programovatelné logické obvody (ASIC). Umo�nila dosáhnout v�ech standardních
funkcí, a navíc øady vlastností, z nich� mnohé nejsou obvyklé nebo principiálnì
dostupné ani u emulátorù podstatnì vy��í cenové kategorie:

l i za plného bìhu emulovaného procesoru lze zobrazovat nebo modifikovat ve�keré
registry (tj. File registry i speciální interní registry jako napø. PC, STACK, PORT,
TRIS, LATCH, OPTION, PRESCALER, WREG, ...). Výjimkou je pouze
zakázaná modifikace STACKu v re�imu Run.

l rozsáhlé mo�nosti zastavení procesoru (Break) na základì mnoha rùzných
podmínek, nejen obvyklé libovolnì nastavitelné breaky v pamìti kódu, ale i breaky
v datové pamìti s volbou pro pøístup k registru, zápis do registru, zápis  hodnoty
omezené maskou a speciální breaky: pøeteèení èasovaèe, pøeteèení trasovacího
bufferu, pøeteèení WDT, pøeteèení/podteèení stacku, break z externí sondy
emulátoru (s volbou nábì�né nebo sestupné hrany)

l mimoøádnì flexibilní nastavení hodinové frekvence emulovaného procesoru
v rozsahu  20 kHz a� 20 MHz s krokem 40 Hz pomocí interního frekvenèního
syntezátoru

l oddìlené napájení vnitøních obvodù emulátoru a I/O pinù emulovaného procesoru
umo�òuje pracovat s aplikaèním napájením v plném rozsahu napájecích napìtí
mikrokontrolérù PIC (3 a� 6V), tj. u�ivatel není nucen pou�ívat pouze napìtí 5 V

l na emulátoru je k dispozici i stabilizovaný zdroj napìtí 5 V s proudovým omezením
100 mA pro napájení periferií emulovaného procesoru

l re�im off-line: po opu�tìní øídícího programu mù�e emulátor pokraèovat v emulaci
nezávisle na øídícím poèítaèi standardu IBM PC

l pøehledná indikace re�imu pomocí rùznobarevných LED pro sledování èinnosti
emulátoru (i v off-line re�imu): oran�ová LED - power on/emulaèní obvod nakon-
figurován, èervená LED - Halted, �lutá LED - Break, zelená LED - Run/Step,
modrá LED - Sleep

l je-li emulátor v èinnosti pøi spu�tìní ovládacího software, nastaví se prostøedí
do stavu, ve kterém bylo pøed jeho opu�tìním. Informace o tomto stavu se ukládají
do speciální pamìti pøímo v hardware emulátoru, ne pouze do konfiguraèního
souboru v PC.
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l  mo�nost povolení nebo potlaèení resetu z pinu -MCLR a od poklesu napájecího
napìtí (rozhodovací úroveò je v tomto pøípadì 2V), detekce i krátkého resetu

l flexibilní trasování - vypnuto, zapnuto, nebo trasování pouze vybraných èástí
programu (lze napø. potlaèit trasování èekacích smyèek, a trasovat pouze prùbìh
hlavního programu). Kapacita trasovacího bufferu je 32 kB, tj. 8192 instrukcí.

l osm sond pro volitelné trasování externích signálù synchronnì se ètením I/O pinù
emulovaného procesoru

l výstup CLKOUT má správnou frekvenci i fázi odpovídající nastavenému re�imu

l korektní emulace pøeteèení èítaèù Watchdog, TMR0 (RTCC) a zápisu do interní
EEPROM (PIC16C8x) i v re�imu Halted/Step, kdy se pøíslu�né èítaèe pozastavují
mimo platný instrukèní cyklus

l flexibilita interních obvodù emulátoru umo�òuje softwarové upgrady hardware
emulátoru (napø. prostøednictvím Internetu), event. individuální modifikace podle
pøání u�ivatele

Integrované vývojové prostøedí DPIC je urèeno pro vývoj aplikací s jednoèipovými
mikropoèítaèi øady 16C5X a 16CXX firmy Microchip. Obsahuje v�echny potøebné
nástroje: editor zdrojového textu, pøekladaè a prostøedky pro ovládání emulátoru firmy
ASIX Praha. Prostøedí standardnì obsahuje demonstraèní verzi simulátoru v�ech podpo-
rovaných klonù rodin 16C5X a 16CXX. Plná verze simulátoru (bez omezení) je
dostupná jako samostatný produkt nezávisle na emulátoru.

Integrované prostøedí obsahuje pøekladaè jazyka assembler, jeho� základní
charakteristiky jsou:

l jedná se o øádkový pøekladaè, tj. na jednom øádku mù�e být pouze jeden pøíkaz

l pracuje se symboly na vy��í úrovni abstrakce, ne� bývá zvykem u obdobných
produktù, umo�òuje definovat a pou�ívat slo�itìj�í datové typy (bajty, bity,
konstanty, pole, tabulky)

l podmínìné øízení pøekladu

l makroinstrukce

l mo�nost volby pøednastavené èíselné soustavy na dekadickou a hexadecimální
(viz. konstanty)

l výstupní binární kód ve formátu INHEX-16 nebo INHEX-8M

l kompatibilní s pøekladaèem firmy Microchip

Integrovaném prostøedí doporuèujeme provozovat na osobním poèítaè standardu
IBM PC s procesorem 486 a 16MB pamìti RAM a s pøibli�nì 4MB volného místa na
pevném disku. Minimální konfigurace poèítaèe, na ní� je mo�né integrované prostøedí
spustit, pøedstavuje poèítaè s procesorem 386SX a alespoò 2MB pamìti RAM.
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2. Popis hardware emulátoru EPIC16A

Rozmìry: 168 (�) x 140 (h) x 42 (v) mm

Teplota okolí pøi provozu: 15 - 30 °C

2.1 Pøední panel

LED Power: blikání resp. trvalé svícení oznaèuje nenakonfigurovaný resp.
nakonfigurovaný emulaèní obvod.

2.1.1 Popis emulaèního konektoru:

1 - +5 V / 100 mA 10 - OSC1/CLKIN 19 - PORTA1 28 - PORTC0
2 - +5 V / 100 mA 11 - nezapojeno 20 - PORTC4 29 - PORTB2
3 - GND 12 - OSC2/CLKOUT 21 - PORTA2 30 - PORTB7
4 - GND 13 - GND 22 - PORTC3 31 - PORTB3
5 - nezapojeno 14 - PORTC7 23 - PORTA3 32 - PORTB6
6 - nezapojeno 15 - nezapojeno 24 - PORTC2 33 - PORTB4
7 - TOCKI (RTCC) 16 - PORTC6 25 - PORTB0 34 - PORTB5
8 - -MCLR 17 - PORTA0 26 - PORTC1
9 - VDD 18 - PORTC5 27 - PORTB1

2
1

34
33

10
9

2
1

Konektor externích sond

Emulaèní konektor

 LED Sleep (modrá)
 LED Stop (èervená)
 LED Break (�lutá)
 LED Run (zelená)
 LED Power (oran�ová)
 Vypínaè napájení

ON   OFF
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2.1.2 Popis konektoru sond

 1 - PROBE 6                6 - PROBE 3
 2 - PROBE 7                7 - PROBE 0
 3 - PROBE 4                8 - PROBE 1
 4 - PROBE 5                9 - GND
 5 - PROBE 2               10 - GND

2.1.3 Barevné oznaèení sond

PROBE 0- bílá PROBE 4 - zelená
PROBE 1- �edá PROBE 5 - �lutá
PROBE 2- fialová PROBE 6 - oran�ová
PROBE 3- modrá PROBE 7 - èervená
GND - èerná

2.2 Zadní panel

2.2.1 Pøipojení emulátoru k PC

Konektor emulátoru je Cannon 25 female, kabel Cannon 25M-25M, propojení
1:1, maximální délka kabelu 2 m.

Upozornìní: Pozor na zámìnu pøedepsaného kabelu s jinak zapojenými kabely,
napø. køí�ovì propojeným kabelem Laplink pro LPT!

1 - STROBE 6 - DATA 4 11 - BUSY 16 - INIT 21 - GND
2 - DATA 0 7 - DATA 5 12 - PE 17 - SLCTIN 22 - GND
3 - DATA 1 8 - DATA 6 13 - SLCT 18 - GND 23 - GND
4 - DATA 2 9 - DATA 7 14 - AUTOLF 19 - GND 24 - GND
5 - DATA 3 10 - ACK 15 - ERR 20 - GND 25 - GND

13
  25

  1
14

Napájecí konektor

Konektor k PC
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2.2.2 Popis napájecího konektoru:

Konektor AMP Shielded Miniature Circular DIN Plug 8 Pin P/N 749179-1 nebo
ekvivalent. Napájecí napìtí 5 V ±5% / 1 A, 12 V ±5% / 500 mA.

Doporuèený typ napájecího zdroje: Computer Products SCL25-7618.

Dùle�ité upozornìní: Pøi nesprávném pøipojení napájecích napìtí mù�e dojít
k vá�nému po�kození emulátoru!

 1 - +5 V                   5 - GND

 2 - +5 V                   6 - GND

 3 - +5 V                   7 - GND

 4 - +12 V                  8 - GND

8 7 6

5 4 3

2 1
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3. Integrované vývojové prostøedí DPIC.

Integrované vývojové prostøedí je tvoøeno nìkolika základními moduly. Do tìchto
modulù poèítáme textový editor, nástroje pro editaci pamìti emulovaného èipu, systém
pro zadávání a editaci událostí, mana�er projektù, pøekladaè a ovladaèe pro jednotlivé
typy emulovaných mikropoèítaèù. V�echny funkce prostøedí jsou dostupné pøes základní
menu, pøièem� neju�ívanìj�í funkce mají pøiøazeny horké klávesy analogicky prostøedí
pøekladaèù firmy Borland. Plnì je podporováno ovládání pomocí my�i.

3.1 Pracovní plocha
Pracovní plocha je základní obrazovka obsahující informace u�iteèné pøi práci

v integrovaném prostøedí. Tato základní obrazovka obsahuje v horní èásti li�tu hlavního

Hlavní menu Aktuální stav emulátoru

Aktivní okno

Pasivní okno

Aktivní nápovìda Jméno projektu Dostupná pamì�
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menu spolu se zobrazením aktuálního stavu emulátoru. Dolní li�ta obrazovky je tvoøena
aktivní nápovìdou tøí nejvýznamnìj�ích horkých kláves, zobrazením jména programu
pøítomného v emulaèní pamìti a informací o velikosti dostupné pamìti v poèítaèi.
Zbytek pracovní plochy je urèen na umístìní oken pro jednotlivé programové nástroje
a objekty.

3.1.1 Programové objekty integrovaného prostøedí

Pojmem programové objekty integrovaného prostøedí se oznaèují základní typy
zobrazení údajù o stavu systému na obrazovku poèítaèe:

l Menu - objekt slou�ící k vyvolání zvolených pøíkazù akcí apod.

l Okna výpisù - objekt ohranièuje jednotlivé výpisy na obrazovce poèítaèe.

l Dialogy - okna, pomocí nich� je realizováno zadávání hodnot, nastavení systému
apod. Od oken výpisù se li�í tím, �e v daném okam�iku je aktivní (schopné pøijímat
pøíkazy) pouze jediné, tj. do okam�iku jeho uzavøení jsou ostatní objekty na pra-
covní plo�e neaktivní.

l Rolovací li�ta - jedná se o objekt, kterým jsou obvykle vybavena okna výpisù.
Objekt reaguje na my� a umo�òuje pohyb výpisu v oknì. Pou�ívá se pøedev�ím
v okam�iku, kdy je poèet sloupcù èi øádkù výpisu vìt�í ne� prostor vymezený
oknem výpisu.

l Tlaèítka - tlaèítka nebo jejich skupiny se pou�ívají na nastavení a volby typu
ano/ne, a na potvrzení nebo zru�ení vyvolané akce. Tlaèítka mohou být bez aretace,
tzn., �e akce je vyvolána prostým stiskem. Reagují na my� nebo na stisk klávesy
zvýraznìného písmena v názvu. Tlaèítka s aretací mohou být sluèovací nebo
vyluèovací. Sluèovací tlaèítka je mo�né zapnout nebo vypnout nezávisle na sobì.
U vyluèovacích tlaèítek, která se vyskytují v�dy v sadì, je mo�né zapnout pouze
jediné v dané sadì.

l Øádkové editory - jedná se o objekt, pomocí nìho� jsou zadávány øetìzce znakù
nebo èíselné konstanty. Editory jsou obvykle vybaveny historií, tj. seznamem,
který obsahuje soupis øetìzcù z pøedchozích provedených zadání. V øadì pøípadù
jsou editory vybaveny i soupisem dostupných jmen, tj. napø. seznamem jmen
známých promìnných. Tento soupis promìnných se v�dy naplní po úspì�ném
pøekladu zdrojového textu.

l Seznamy - seznamy jsou objekty, které sdru�ují soubor povelù nebo mo�ností
volby. Volba se provádí pomocí kurzoru a stisku klávesy Enter.
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3.1.2 Menu

V�echny polo�ky menu je mo�né ovládat buï z klávesnice nebo pomocí my�i.
Pro vstup do menu slou�í klávesa F10, pohyb v menu se provádí pomocí kurzorových
kláves po jednotlivých polo�kách nebo stiskem zvýraznìného znaku v názvu polo�ky.
Polo�ky hlavního menu a nìkterých pøíkazù mají pøiøazeny je�tì horké klávesy pro
usnadnìní výbìru polo�ky. Horké klávesy polo�ek li�ty hlavního menu jsou
konstruovány jednotnì v systému zvýraznìné písmeno a klávesa Alt (napø. File Alt-F,
Debug Alt-D). Volba pøíkazu menu pomocí my�i je slo�ena z vyhledání polo�ky menu
kurzorem my�i a ze stisku levého tlaèítka.

3.1.3 Okna výpisù

Okna výpisù, editorù, atd. se pøi práci nacházejí buï v aktivním (vybraném) stavu
nebo ve stavu neaktivním. Tyto stavy oken jsou rozli�eny typem rámeèku (jednoduchý
rámeèek = neaktivní okno, dvojitý rámeèek = aktivní okno).

Okno v aktivním stavu pøijímá povely z klávesnice a pøíkazy menu. V neaktivním
stavu na tyto akce okno nereaguje. Na pracovní plo�e mù�e být aktivní v�dy jen jediné
okno.

Aktivitu okna je mo�né volit buï z klávesnice pomocí pøíkazù �Window→Next�
(F6) a �Window→Previous� (Shift-F6) nebo kursorem my�i se souèasným potvrzením
volby aktivity pomocí stisku levého tlaèítka.

Mezi dal�í atributy okna patøí:

l Jméno okna - jméno je umístìné uprostøed horní hrany rámeèku. Informuje
v pøípadì textového editoru o jménu editovaného souboru a v ostatních pøípadech
o typu výpisu v oknì.

l Rolovací li�ty - umo�òují posun textu v oknì vodorovným nebo svislým smìrem.

l Ikona pro uzavøení okna - reaguje na my� a vyvolá uzavøení okna a jeho odstranìní
z pracovní plochy. Je umístìna na rámeèku v levém horním rohu okna. Uzavøení
okna je mo�né provést té� pøíkazem �Window→Close� (Alt-F3) z hlavního menu.

l Ikona rozmìru okna - je umístìna na pravém dolním rohu rámeèku okna.
Umo�òuje mìnit plynule velikost okna a reaguje na my� nebo na pøíkaz hlavního
menu �Window→Resize� (Ctrl-F5).

F10 = Menu
Alt-Sp Alt-F Alt-W Alt-E Alt-V Alt-R Alt-D Alt-O
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3.1.3.1. Pohyb oknem po pracovní plo�e

Okna po pracovní plo�e je mo�né pøesouvat, zvìt�ovat a nebo zmen�ovat.

a) Pøesunutí okna my�í - kurzor my�i umístíme na rámeèek aktivního okna mimo
ikonu rozmìru okna, uzavøení okna a zvìt�ování okna. Stiskneme levé tlaèítko a
pøi jeho dr�ení pohybujeme my�í. Okno sleduje pohyb my�i. V okam�iku, kdy
jsme s jeho polohou spokojeni, uvolníme tlaèítko my�i a tím okno umístíme.

b) Pøesunutí okna klávesnicí - pøíkazem �Window→Resize� pøepneme okno
do re�imu editace rozmìru. Pomocí kursorových kláves vyhledáme po�adovanou
polohu okna a umístíme ho stiskem klávesy Enter.

c) Úprava rozmìru pomocí my�i - kurzor my�i umístíme na ikonu rozmìru okna a
stiskneme levé tlaèítko. Pohybujeme kursorem my�i za souèasného dr�ení tlaèítka.
Levý dolní roh okna sleduje pohyb kurzoru, zatímco zbytek okna polohu nemìní.
Tímto zpùsobem nastavíme po�adovanou velikost okna a okno zafixujeme
uvolnìním tlaèítka my�i.

d) Úprava rozmìrù pomocí klávesnice - pøíkazem hlavního menu �Window→Resize�
pøepneme okno do re�imu editace rozmìru. Pomocí kombinace klávesy Shift
s kursorovými klávesami nastavíme po�adovanou velikost okna a zafixujeme
ji stiskem klávesy Enter.

Ikona pro uzavøení Ikona zvìt�ováníJméno okna

Indikátor øádkù a sloupcù Ikona rozmìru okna

Rolovací
li�ty

l Ikona zvìt�ování - je umístìna v pravém horním rohu a reaguje na my� nebo
na pøíkaz �Window→Zoom� (F5). Ikona pøepíná maximální a nastavený rozmìr
okna.

l Indikátor øádkù a sloupcù - je umístìn v levém dolním rohu okna a ukazuje
u textového editoru polohu kurzoru ve formátu [øádek:sloupec].
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e) Zvìt�ení okna pomocí my�i - zvìt�ení okna na maximální rozmìr nebo zpìt
na rozmìr pùvodní provedeme umístìním kurzoru my�i na ikonu zvìt�ování a
stiskem levého tlaèítka.

f) Zvìt�ení okna pomocí klávesnice - zvìt�ení okna na maximální rozmìr  nebo zpìt
provedeme stiskem horké klávesy F5 nebo pøíkazem �Window→Zoom� hlavního
menu.

3.1.3.2 Pohyb textem okna

a) Pohyb textem okna pomocí my�i - my�í je mo�né pohybovat textem v oknì
za pomoci rolovacích li�t. Posunutí textu o jeden znak nebo øádek provedeme
umístìním kurzoru my�i na ikonu jednotkového posunu a stiskneme levé tlaèítko.
Text se posune v závislosti na zvolené ikonì a rolovací li�tì o jeden znak vlevo
nebo vpravo (horizontální li�ta) resp. o jeden øádek nahoru nebo dolù (vertikální
li�ta). Podobnì je mo�né posunout text o stránku umístìním kurzoru my�i na li�tu
mezi ikonu jednotkového posunu a kurzor li�ty s následným stisknutím levého
tlaèítka my�i. Posun do obecné polohy provedeme umístìním kurzoru my�i
na kurzor rolovací li�ty. Poté souèasným stiskem levého tlaèítka my�i a posunem
kurzoru my�i pøemístíme kurzor rolovací li�ty na po�adovanou polohu. Uvolnìní
tlaèítka my�i vyvolá posun textu v oknì.

b) Pohyb textem okna pomocí klávesnice - nejprve pøemístíme kurzor ke kraji okna
v po�adovaném smìru pro pohyb textu. Poté stisknutím odpovídající kurzorové
klávesy posunujeme text v po�adovaném smìru.

3.1.4 Dialogová okna

Dialogová okna slou�í obvykle k nastavení rùzných pøedvoleb integrovaného
prostøedí. Na pracovní plo�e je mo�né umístit pouze jediné okno tohoto typu, pøièem�
aktivita ostatních objektù je a� do uzavøení dialogu potlaèena. Uvnitø dialogového
okna jsou nastavovací objekty (nejèastìji tlaèítka, øádkové editory). Z tìchto objektù
je v�dy aktivní pouze jeden, a tudí� pouze s jedním je mo�né pracovat. Chceme-li
pøejít na nastavování parametrù v jiném objektu, stiskneme opakovanì klávesu Tab,
a� je aktivován po�adovaný objekt. Druhou mo�ností je umístit kurzor my�i na
po�adovaný objekt a stisknout levé tlaèítko my�i. Poslední mo�ností je pou�ít horké
klávesy pro vybraný objekt. Horká klávesa je konstruována z kombinace zvýraznìného
znaku v názvu objektu s klávesou Alt. Editace a nastavování parametrù v jednotlivých
objektech je popsáno v kapitolách Tlaèítka s aretací, Øádkový editor, Seznamy, Objekt
historie, Objekt nabídky.

Ka�dé dialogové okno je vybaveno ikonou uzavøení, která reaguje na my�, a má
význam ignorování zmìn v nastavení. Dále pak jsou dialogová okna vybavena tlaèítky
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bez aretace, která slou�í v pøevá�né míøe k akceptování èi zru�ení zmìn v nastavení
s následným uzavøením okna po jejich stisku. Jedno z tlaèítek dialogového okna je
v�dy vybráno, a je mo�né vyvolat jeho funkci z jakéhokoli objektu dialogového okna
stiskem klávesy Enter.

3.1.5 Rolovací li�ta

Rolovací li�ta je pomocný ovládací objekt pøevá�nì pro okna výpisù. Objekt má
tøi oblasti, které reagují na kurzor my�i za souèasného stisku levého tlaèítka. Jedná se
o oblasti:

a) Ikony jednotkového posunu - tyto ikony jsou umístìny na okrajích rolovací li�ty a
pøi jejich �stisknutí� se pøedává povel odpovídajícímu oknu s údajem o smìru
pohybu s jednotkovým krokem.

b) Kurzor li�ty - kurzor rolovací li�ty se mù�e pohybovat v rozmezí ikon jednotkového
posunu. Kurzorem my�i najedeme na kurzor rolovací li�ty. Poté stikneme levé
tlaèítko my�i a souèasnì pohybujeme kurzorem my�i v po�adovaném smìru. Kurzor
rolovací li�ty následuje kurzor my�i. Po uvolnìní tlaèítka se pøedá povel s údajem
o pozici kurzoru rolovací li�ty a podle hodnoty se provede posun textu na po�a-
dovaný øádek nebo sloupec.

c) Prostor na li�tì - prostor na li�tì mezi ikonami a kurzorem rolovací li�ty reaguje
na my� vysláním povelu na odstránkování textu pøíslu�ného okna o stránku vpøed
èi vzad.

Vertikální li�ta

Horizontální li�ta

Kurzor li�ty

Ikony
jednotkového

posuvu
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3.1.6 Tlaèítka

Tlaèítka mohou být tøech typù:

a) Tlaèítko bez aretace - tlaèítko bez aretace je objekt, který slou�í k potvrzování
èi ru�ení volby. Reaguje na ovládání my�í, tj. na kurzor my�i a stisk levého tlaèítka
my�i. Z klávesnice se tlaèítka ovládají pomocí stisku klávesy odpovídající
zvýraznìnému znaku ve jménu tlaèítka.

b) Sluèovací tlaèítka - sluèovací tlaèítka jsou obvykle sdru�ena po skupinách
do jediného objektu. Jsou oznaèena jménem se zvýraznìným znakem, který
odpovídá horké klávese konstruované z klávesy Alt a zvýraznìného znaku.
Pro pohyb kurzoru ve skupinì sluèovacích tlaèítek jsou urèeny kurzorové klávesy.
Zapnutí resp. vypnutí tlaèítka provedeme stiskem mezerníku na vybraném tlaèítku.
My�í se tlaèítka zapínají resp. vypínají tak, �e umístíme kurzor my�i na ikonu
tlaèítka ([  ] resp. [X]) a stiskneme levé tlaèítko my�i.

c) Vyluèovací tlaèítka (radio tlaèítka) - vyluèovací tlaèítka jsou uspoøádána do skupin,
a od sluèovacích tlaèítek se li�í tím, �e mù�e být zapnuto v�dy pouze jediné tlaèítko
ve skupinì. Ovládání zapínání tlaèítka pomocí klávesnice a my�i je stejné jako
ovládání tlaèítek sluèovacích.

Vyluèovací
tlaèítka Sluèovací

tlaèítka

Øádkový
editor

Tlaèítka bez aretace
(potvrzení/zru�ení volby)
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3.1.7 Øádkové editory

Pomocí øádkových editorù zadáváme èíselný nebo textový údaj. Øádkové editory
jsou ve vìt�inì pøípadù vybaveny objektem historie a objektem nabídky dostupných
symbolù.

Editaci textu provádíme pomocí standardních kláves editorù:

l kurzorové klávesy pro pohyb kurzoru

l Ins pro pøepínání re�imu vkládání a pøepisování textu

l Del pro mazání znaku

l Home pro pøesunutí kurzoru na zaèátek textu

l End pro pøesunutí kurzoru na konec textu

Pro vyvolání podpùrných programových objektù pou�íváme:

l �ipka dolù pro vyvolání objektu historie

l Ctrl-Enter pro vyvolání objektu dostupných symbolù

Podpùrné programové objekty jsou tvoøeny seznamy, jejich� ovládání je popsáno
v kapitole 3.1.8 a 3.1.9.

Pomocí objektu historie, ve kterém jsou ulo�eny v�echny pøedcházející editované
øetìzce znakù, mù�eme snáze a rychleji zadávat ji� jednou zadané øetìzce.

V objektu dostupných symbolù jsou pro usnadnìní zadávání k dispozici v�echna
aktuálnì známá jména a symboly generované pøi úspì�ném pøekladu zdrojového textu.

Øádkový
editor Objekt historie

Objekt dostupných symbolù
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3.1.8 Seznamy

Seznamy jsou objekty obsahující soupisy jmen a symbolù, pøièem� s tìmito soupisy
pracují jako s databází. Kurzorem je mo�né vybrat zvolenou polo�ku a pomocí klávesy
Enter ji potvrdíme. Polo�ku mù�eme takté� vybrat pomocí my�i. Umístíme na ni kurzor
my�i a stiskneme levé tlaèítko. Je-li v seznamu více polo�ek ne� je mo�né v odpoví-
dajícím prostoru zobrazit, pak je seznam doplnìn rolovací li�tou. Pomocí rolovací
li�ty pak mù�eme listovat seznamem pøes v�echny jeho polo�ky.

3.1.9 Podpùrné programové objekty

Podpùrné programové objekty jsou urèeny pro usnadnìní zadávání jmen a symbolù
popøípadì matematických výrazù. Integrované prostøedí nabízí tyto podpùrné
programové objekty.

l Historie [↓] - objekt historie souvisí v�dy s øádkovým editorem. Na pracovní
plo�e dialogového okna má vyhrazenu ikonu, která reaguje na klávesnici nebo
my� pouze v okam�iku, je-li aktivován jí pøíslu�ející editor. Stiskneme-li klávesu
�ipka dolù (kurzorová klávesa), pak se ikona historie rozvine v seznam, který
obsahuje v�echny pøede�lé textové øetìzce zadávané editorem do prostøedí.
Po stisku klávesy Enter je vlo�en vybraný øetìzec do editoru a seznam je zpìt
nahrazen ikonou. Uzavøení seznamu bez vlo�ení textu provedeme klávesou Esc.

l Dostupné symboly [√] - objekt dostupných symbolù je seznam obdobný seznamu
historie. Má stejné ovládání a úèinky. Od seznamu historie se li�í tím, �e je plnìn
po úspì�ném pøekladu pøekladaèem. Pod pojmem dostupné symboly rozumíme
jména, která lze v zadaném výrazu vyhodnotit.
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3.2 Hlavní menu
Hlavní menu integrovaného prostøedí tvoøí ovládací

li�ta v horní èásti pracovní plochy. Základní nabídku tvoøí
polo�ky ≡, File, Window, Edit, Views, Run, Debug a
Options.

3.2.1 Nabídka ≡≡≡≡≡

Nabídka oznaèená znakem ≡ obsahuje pomocné
nástroje a informace, které pomáhají pøi vývoji aplikací.
Nabídka je tvoøena polo�kami:

l Ascii - zobrazení roz�íøené tabulky ASCII znakù,
vèetnì pøevodù na èíselné kódy.

l Calculator - vyvolání programového modulu
realizujícího kalkulátor v pevné øádové èárce,
základními operacemi vèetnì pøevodù èísel mezi
jednotlivými èíselnými soustavami.

l Videostop - jednoduchá hra pro chvíle úplného
vyèerpání

l Information - zobrazení základních informací
o verzi integrovaného prostøedí, pøekladaèe a
emulátoru.

l About - zobrazení jmen a informací o autorech
programu

3.2.2 Nabídka File

Nabídka File je souhrnem pøíkazù pro práci
se soubory, projekty, adresáøi atp. Obsahuje následující
polo�ky rozdìlené do nìkolika skupin.

Skupina pro práci se soubory:

l New File - umo�ní otevøít a pomocí editoru editovat
nový soubor

l Open File (F3) - umo�ní otevøít ji� existující, popø.
zalo�it nový soubor zdrojového textu.

l Save File (F2) - pøíkaz k ulo�ení obsahu libovolného
objektu na pracovní plo�e. Objektem je mínìn
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textový soubor nebo obsah libovolného progra-
mového nástroje pro editaci pamìti emulaèního
obvodu.

l Save as - pøíkaz slou�í k ulo�ení textu zdrojového
souboru pod novým zadaným názvem.

Skupina pro práci s projektem:

Tato skupina je urèena k ovládání mana�eru projektù.
Mana�er projektù umo�òuje efektivnì pracovat souèasnì
na více projektech tím, �e zabezpeèuje ulo�ení nastavení
rozpracovaného problému pøi pøeru�ení práce.
Pøi opìtovném otevøení projektu je prostøedí z aktuálního
stavu pøenastaveno podle definic ulo�ených v projektu.

l New Project - pøíkaz umo�òuje otevøít zcela nový
projekt s tím, �e prostøedí je nastaveno na implicitní
hodnoty.

l Open Project (Shift-F3) - otevøení ji� exitujícího
projektu

l Save Project (Shift-F2) - ulo�ení nastavení projektu
do definièního souboru projektu

l Close Project (Ctrl-F3) - ukonèení práce v aktuálnì
otevøeném projektu

l Save Project as - ulo�ení nastavení projektu podle
zadaného jména

Skupina vstupù a výstupù:

l Load Hex - inicializace emulaèní pamìti obsahem
souboru ve formátu Intel HEX-16.

l Save Hex - ulo�ení obsahu emulaèní pamìti
ve formátu Intel Hex-16.

Ostatní pøíkazy:

l Change Dir - zmìna pracovního adresáøe

l DOS Shell - spu�tìní programové øádky DOSu.
Vzhledem k pomìrnì znaènému vyu�ití konvenèní
pamìti není obvykle mo�né spustit z pøíkazové øádky
dal�í program.

l Exit (Alt-X) - ukonèení práce a opu�tìní programu.
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3.2.3 Nabídka Window

 Nabídku Window tvoøí pøíkazy pro práci s okny
jednotlivých programových nástrojù pro editaci emulaèní
pamìti a pro textový editor zdrojového textu. Nabídka
obsahuje následující pøíkazy:

l Next (F6) - pøepnutí z aktivního okna na následující.
Aktivní okno je zvýraznìno dvojitou èarou rámeèku

l Previous (Shift-F6) - pøepnutí z aktivního okna
na pøedcházející okno v øadì.

l Zoom (F5) - pøepnutí aktivního okna z aktuální veli-
kosti na  velikost maximální a zpìt.

l Close (Alt-F3) - uzavøení aktivního okna.

l Resize (Ctrl-F5) - pøepnutí okna do re�imu zvìt�o-
vání a zmen�ování, pøípadnì pohybu oknem po pra-
covní plo�e.

l Tile - uspoøádání oken po plo�e obrazovky tak, aby
byla v�echna otevøená okna viditelná. Tento re�im
je vhodný pøi pomìrnì malém poètu otevøených
oken.

l Cascade - uspoøádání oken za sebe. Uspoøádání
pøipomíná jednotlivé lístky kartotéky.

3.2.4 Nabídka Edit

Nabídka Edit zahrnuje pøíkazy a nástroje pro textový
editor. Nabídka se skládá z tìchto povelù:

l Undo - vrácení poslední úpravy textu napø. vyma-
zání slova èi øádku.

l Cut (Shift-Del) - vystøi�ení bloku oznaèeného textu
(pøed vystøi�ením je oznaèený text zkopírován do
pomocného editoru)

l Copy (Ctrl-Ins) - zkopírování oznaèeného textu
do pomocného editoru (Clipboard)

l Paste (Shift-Ins) - pøenesení textu z pomocného
editoru do editovaného textu.
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l Show Clipboard - zobrazení obsahu pomocného
editoru.

l Clear (Ctrl-Del) - vymazání oznaèeného textu bez
náhrady

l Find - vyhledání zadaného øetìzce znakù (slova)

l Replace - vyhledání øetìzce znakù a jeho nahrazení
øetìzcem zadaným.

l Search again - opìtovné vyhledání zadaného
øetìzce v textu.

l Mark - umístìní znaèky na øádek textu, který
odpovídá pozici kurzoru. Funkce slou�í k oznaèení
místa textu, na které se chceme vrátit pomocí pøíkazu
�Goto Mark�

l Goto Mark - návrat na øádek oznaèený znaèkou.
Øádek oznaèíme pomocí pøíkazu "Mark"

3.2.5 Nabídka Views

Nabídka Views sdru�uje pøíkazy na spou�tìní
jednotlivých nástrojù pro editaci emulaèní pamìti.
K dispozici jsou pøíkazy:

l Watch - spu�tìní zobrazování a editace programo-
vých promìnných podle u�ivatelské volby.

l Data Memory (Alt-M) - zobrazení celého obsahu
datové pamìti (registrové) banky emulovaného
mikropoèítaèe.

l Breaks - zobrazení databáze událostí. Mezi události
jsou zahrnuty v�echny typy breakù (bod zastavení
bìhu programu) a události podmínìného trasování.

l Stack (Alt-S) - zobrazení obsahu zásobníku
se zvýraznìním ukazatele zásobníku (Stack Pointer).

l Program (Alt-P) - zobrazení obsahu programové
pamìti.

l Trace (Alt-T) - zobrazení obsahu trasovací pamìti

l Disassembler - zobrazení obsahu programové
pamìti vèetnì disasemblování do mnemoniky
instrukèního souboru.
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l Errors & Messages (Alt-A) - zobrazení okna chyb
a varování vzniklých pøi pøekladu.

l Clear Error Reference (Alt-C) - potlaèení
barevného podsvícení chybné øádky ve zdrojovém
textu.

3.2.6 Nabídka Run

Nabídka Run je urèena pro pøíkazy související
se zpracováním zdrojového textu pøekladaèem a s rùzný-
mi druhy spou�tìní a bìhu programu aplikace.

Nabídka zahrnuje tyto povely:

l Compile (Alt-F9) - pøeklad zdrojového textu
programu aplikace

l Run (Ctrl-F9) - spu�tìní programu v emulaèní
pamìti. Spu�tìní programu není blokováno ani pøi
neúspì�ném pøekladu z dùvodu chyb. V takovém
pøípadì bude provádìn buï program podle
posledního úspì�ného pøekladu a nebo program
podle náhodného obsahu programové pamìti.

l Goto (F4) - pøíkaz provede spu�tìní programu
k pozici kurzoru ve zdrojovém textu

l Emulator reset (Ctrl-F2) - provede se reset emulá-
toru tj. emulovaný procesor se nastaví shodnì s kata-
logovou specifikací stavu reset.

l Step Over (F8) - program se spustí podle aktuálního
obsahu programové pamìti na jeden krok, pøièem�
jeden krok mù�e odpovídat buï jedné instrukci,
podprogramu nebo makru. V tomto pøípadì se tedy
jedná o krokování programem s tím, �e makra a
podprogramy jsou provádìny plnou rychlostí.

l Trace Into (F7) - krokování programu po instrukcích

l Line Asm - vyvolání øádkového pøekladaèe.
Nejèastìji se tento povel uplatní pøi drobných kore-
kturách programu pøímo v programové pamìti.
Pozor - pøíkaz sice zmìní obsah programové pamìti,
ale tato zmìna není promítnuta do zdrojového textu.
Dochází tak k nekonzistenci zdrojového textu a
programu.
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l Make instruction - pøíkaz umo�òuje vykonat
instrukci tzv. mimo poøadí tj. nezávisle na obsahu
programové pamìti.

l Animate - pøíkazem se uvádí emulátor do re�imu
animace, tj. re�imu, kdy je aplikaèní program
automaticky krokován, a po ka�dém kroku je kom-
pletnì vyèten obsah datové pamìti a stav ostatních
vnitøních registrù emulovaného procesoru.

3.2.7 Nabídka Debug

V nabídce Debug jsou zahrnuty v�echny dostupné
pøíkazy pro modul debuggeru. Jedná se o modul
umo�òující zadávat a modifikovat interní registry emulo-
vaného mikroprocesoru, které jsou programovì nepøí-
stupné. Jsou k dispozici tyto pøíkazy:

l New Stack - pøíkazem je mo�né editovat obsah
zásobníku.

l New SP - nastavení nové hodnoty ukazatele
zásobníku.

l New PC - nastavení nové hodnoty programového
èítaèe.

l Add Watch - pøíkazem se pøidá polo�ka do u�ivatel-
ského formátu zobrazení (Watch).

l Toggle Break (Ctrl-F8) - zadání prostého
adresového breaku (bod zastavení bìhu programu
na zadané adrese).

l Add Break (Alt-B) - zadání nového breaku nebo
události pomocí editoru událostí.

l Global Events (Alt-G) - nastavení a konfigurace
pro v�eobecné události, pøi nich� má dojít k zasta-
vení bìhu programu.

3.2.8 Nabídka Option

Nabídka Option sdru�uje v�echna u�ivatelská
nastavení, a to jak prostøedí, tak emulátoru. K dispozici
jsou pøíkazy:
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l Emulator Setup - nastavení parametrù emulátoru,
napø. hodinový kmitoèet, typ procesoru apod.

l Compiler - nastavení parametrù pøekladaèe, formátu
výpisu a formátu výstupního souboru pøekladaèe.

l Chip Options - nastavení specifických parametrù
emulovaného procesoru. Jedná se o mo�nost
nastavení napø. módu oscilátoru, povolení �start up
timeru�, povolení �wakeup timeru�, povolení
obvodu �watchdog� apod. Toto nastavení se odli�uje
pro ka�dý typ procesoru (popø. rodinu procesorù).
Ve znaèné míøe odpovídají polo�ky nastavení
konfiguraènímu bajtu procesoru (nastavení pojistek).

l Data Memory Setup - nastavení parametrù výpisu
datové pamìti emulovaného procesoru

l Program Memory Setup - nastavení parametrù
výpisu programové pamìti emulovaného procesoru

l Trace Memory Setup - nastavení parametrù výpisu
trasovací pamìti emulovaného procesoru

l Environment - u�ivatelské nastavení prostøedí

l Colors - nastavení barev jednotlivých objektù a
výpisù na obrazovku.

l Redump Emul - pøíkazem je znovu vyèten úplný
obsah emulaèní pamìti a stavu emulátoru.

3.3 Zdrojový text, projekt a objekt
Vývoj aplikace s pomocí integrovaného prostøedí lze realizovat nìkolika cestami.

Pro jednoduché pokusy je mo�né vyu�ít pøímo pøekladu zdrojového textu programu.
Pro slo�itìj�í aplikace nebo pøi vývoji programù, u nich� je nezbytné udr�et konzistenci
s dal�ími prvky vývoje, napø. s plo�ným spojem a pøiøazením vývodù procesoru apod.,
doporuèujeme pou�ít mo�nosti konstrukce projektu.

3.3.1 Organizace adresáøù

Pøi vývoji aplikací je nutné mít na pamìti systém ulo�ení informací o zpraco-
vávaném programu na pevném disku poèítaèe. Integrované prostøedí rozpoznává
v zásadì v�dy dva adresáøe, které mù�eme oznaèit jako adresáø instalace a adresáø
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pracovní. Pojmem adresáø instalace máme na mysli adresáø obsahující nezbytnì nutné
soubory pro instalaci a spu�tìní prostøedí. Tento adresáø je sice mo�né pou�ívat jako
pracovní, ale z dùvodu bezpeènosti ulo�ených dat to nelze doporuèit. Navíc pøi instalaci
na poèítaèové síti je obvyklé omezení pøístupových práv pro bì�né u�ivatele. Instalaèní
adresáø mù�e mít nastaven atribut read-only (integrované prostøedí vyu�ívá adresáø
pouze ke ètení dat). Pojmem pracovní adresáø oznaèujeme libovolný adresáø, do nìho�
je mo�né zapisovat a z nìho� je mo�né èíst data. V tomto adresáøi vytváøí systém v�dy
standardní konfiguraèní projekt, tj. soubor oznaèený DPIC.PRJ a soubor palety barev
DPIC.CFG. Soubor standardního projektu obsahuje informace o nastavení prostøedí
pøi posledním spu�tìní, v nìm� nebyl otevøen �ádný u�ivatelský projekt. Soubor palety
barev obsahuje u�ivatelské kódy barev pro v�echny projekty v daném pracovním
adresáøi.

3.3.2 Zdrojový text a projekt

Zdrojový text programu vytváøíme textovým editorem. Soubor je mo�né otevøít a
ulo�it pomocí nabídky File v hlavním menu. V pøípadì, �e pí�eme zdrojový text bez
otevøení projektu, mù�e být soubor nazván libovolným platným názvem pro operaèní
systém MS DOS. Je-li v�ak zdrojový text psán v otevøeném projektu, pak hlavní soubor
zdrojového textu tohoto projektu musí mít s projektem shodný název. Po uzavøení
projektu je vytvoøen v pracovním adresáøi konfiguraèní soubor projektu �jméno.PRJ�.
Podle jména projektu je pak hledán na pevném disku hlavní soubor projektu se zdro-
jovým textem a souèasnì, pokud existuje, i pøíslu�ný soubor objektu.

3.3.3 Soubor objektu

Soubor objektu je vytvoøen pøekladaèem na základì úspì�ného ukonèení pøekladu.
Soubor obsahuje kromì operaèních kódù instrukcí dal�í dùle�ité informace, napø.
o umístìní promìnných v datové pamìti nebo o umístìní programových návì�tí v pamìti
programu. V pøípadì, �e je otevøen projekt, má soubor objektu pøiøazeno shodné jmého
se jménem hlavního zdrojového textu, a tudí� i se jménem projektu.

3.3.4 Projekt

Vzhledem k tomu, �e prostøedí umo�òuje mít na pracovní plo�e otevøeno více
textových souborù se zdrojovým ale i obecným textem, je nezbytné øe�it prioritu
pøekladu zdrojového textu. V prostøedí platí: je-li otevøen projekt, volá se v�dy, a to
nezávisle na aktivitì toho èi onoho okna se zdrojovým textem, pøeklad hlavního souboru
�Projektu�. V pøípadì, �e projekt otevøen není, je pøelo�en zdrojový text právì aktivního
editoru. Pro manipulaci s projekty slou�í pøíkazy z nabídky File hlavního menu.
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3.4 Editor zdrojového textu
Editor zdrojového textu umo�òuje zpracovávat zdrojový text do velikosti 64 KByte.

V nìkterých pøípadech, a to pøevá�nì pøi bohatém komentáøi zdrojového textu, mù�e
dojít k vyèerpání tohoto rozsahu. Aby u�ivatel nebyl omezován, mù�e uvedenou situaci
øe�it pomocí direktivy vlo�ení souboru. Tato direktiva umo�ní zahrnout do pøekladu
více souborù zdrojového textu a tím umo�ní i roz�íøení pamì�ových mo�ností
pro editaci. U rozsáhlej�ích aplikací doporuèujeme rozdìlení zdrojového souboru
do více èástí nejen z dùvodu omezení pamì�ového prostoru editoru, ale i vzhledem
k pøehlednosti textu.

3.4.1 Editace textu

l pøesunutí kurzoru - pohyb kurzoru po aktivní plo�e editoru je provádìn pomocí
kurzorových �ipek po jednotlivých znacích, pomocí kombinace kláves Ctrl→ a
Ctrl← po jednotlivých slovech. Kurzor je mo�né pøemístit i pomocí my�i
umístìním kurzoru my�i na po�adovaný znak, a stisknutím levého tlaèítka

l oznaèování bloku textu - oznaèení bloku textu je mo�né buï pomocí kombinace
kláves Ctrl-KB pro zaèátek a Ctrl-KK pro konec bloku nebo pohybem my�i
za souèasného dr�ení levého tlaèítka.

l zru�ení oznaèení bloku - oznaèení bloku zru�íme buï pohybem kurzoru
po ukonèení oznaèení bloku a nebo pomocí kombinace kláves Ctrl-H.

l pøesunutí a kopie textu - pro  pøesun a  kopii textu  je vyu�it  skrytý editor
(clipboard). Zvolený text oznaèíme a pomocí menu nebo horkých kláves
zkopírujeme do skrytého editoru. K pøesunu textu volíme vystøi�ení, tj. pøíkaz
�Edit→Cut� (Shift-Del), ke zkopírování volíme pøíkaz �Edit→Copy� (Ctrl-Ins).
Poté pøesuneme kurzor na pozici nového vlo�ení textu a volíme pøíkaz
�Edit→Paste� (Shift-Ins).

l vymazání textu, bloku - pro vymazání textu je k dispozici klávesa Del (vyma�e
písmeno na pozici kurzoru), klávesa Back-Space (vyma�e písmeno pøed pozicí
kurzoru) a pøíkaz �Edit→Clear� (Ctrl-Del), kterým je mo�né vymazat celý
oznaèený text.

l zru�ení vymazání - pro zru�ení posledního vymazání textu a jeho navrácení
do pùvodní podoby pou�ijeme pøíkaz �Edit→Undo�.

l zobrazení skrytého editoru - zobrazení obsahu skrytého editoru vyvoláme
pøíkazem �Edit→Show Clipboard�.



30 DPIC/EPIC - u�ivatelská pøíruèka

l funkce hledání øetìzce v textu (pøíkaz �Edit→→→→→Find�) - editor umo�òuje
vyhledávat sekvence znakù bez nebo s rozli�ením malých a velkých písmen,
s mo�ností zvolit hledání pouze celých slov.

l funkce nahrazení textu - pøíkazem �Edit→Replace� vyvoláme funkci
vyhledávání textu a nahrazování textem jiným. Pøíkazem je mo�né vyhledávat
bez nebo s rozli�ením malých a velkých písmen, vyhledávání omezit pouze celými
slovy a vyhledat první nebo v�echny výskyty zadaného textového øetìzce.
Souèasnì je mo�né zvolit automatické nahrazení nebo nahrazení s potvrzením
od u�ivatele.

3.4.2 Dal�í pomocné funkce editoru

l funkce automatické volby zaèátku øádku (Autoindent) - volbou této funkce
v nastavení prostøedí uvedeme editor do stavu, ve kterém pøi pøechodu na dal�í
øádek nastavuje pozici kurzoru podle poèátku øádku pøedchozího. Není-li funkce
nastavena, pak je kurzor po pøechodu na dal�í øádek umístìn v�dy na první sloupec
textové obrazovky.

l funkce zvýraznìní syntaxe (Highlight) - funkce se volí globálnì pro v�echny
objekty integrovaného prostøedí v u�ivatelském nastavení, a tudí� na ni reaguje
i editor. Tato funkce barevnì odli�uje klíèová slova od ostatního zdrojového textu.

l funkce zobrazení èítaèe instrukcí - pøi emulaci provádí mikropoèítaè aplikaèní
program podle zadaných instrukcí, pøièem� se mìní hodnota programového èítaèe.
Editor prùbì�nì zobrazuje hodnotu programového èítaèe pomocí barevného
podsvícení øádku se zápisem instrukce, její� umístìní v programové pamìti
odpovídá aktuální hodnotì programového èítaèe.

l funkce pro zobrazení bodù zastavení a bodù trasování - tyto funkce umo�òují
zadat a zobrazit adresový bod zastavení (Address Break) a zobrazit bod trasování.
Bod trasování je zobrazen zvýraznìním prvního znaku na øádce, bod zastavení
pak zvýraznìnou barvou øádky. Pokud je prvním znakem øádky mezera, je bod
trasování oznaèen znakem ±

l funkce pevných odkazù na chyby a body zastavení programu - jedná se
o pomocnou funkci editoru. Funkce umo�nuje editaci zdrojového textu, v nìm�
jsou vyznaèeny chyby pøekladaèem tak, �e pøi pøípadném vypu�tìní øádku,
èi jeho vlo�ení, sleduje editor nové relativní polohy tohoto oznaèení chyby. Takté�
je tato funkce vyu�ita pro posuvy poloh znaèek pro body zastavení a body
podmínìného trasování. Detailnì jsou tyto funkce popsány v kapitole 3.19.
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3.5. Editor datové a programové pamìti
Editory datové a programové pamìti jsou nástroje na pøímou editaci pamì�ového

prostoru emulovaného mikroprocesoru. Jedná se o maticovì orientované výpisy. První
sloupec výpisu obsahuje v�dy adresu prvního bajtu èi slova na pøíslu�ném øádku
zobrazení.  Dále jsou uvedeny hodnoty následujících pamì�ových bunìk. Napø.

08: 12 33 AB CD
0C: 15 1F E0 A1

V uvedeném pøíkladu je tedy na adrese 8 hodnota 12, na adrese 9 hodnota 33 atd.

Adresy jsou vypisovány v�dy v hexadecimální soustavì, zatímco pro výpis obsahu
pamìti je mo�né volit jeden z pìti formátù výpisu a to v soustavì hexadecimální,
dekadické, binární, oktalové a pomocí ASCII znakù. Dále je mo�né zvolit poèet sloupcù
výpisu od 1 do 6 a nastavit pro nì poèet vypisovaných znakù. V�echny tyto volby je
mo�né provést pomocí pøíkazù �Option→Data Memory Setup� resp.
�Option→Program Memory Setup� v nastavení formátu výpisu pamì�ového prostoru
na obrazovku.

l pohyb kurzorem - editory obsahu pamìti zobrazují kurzory dva. První z nich je
shodný s kurzorem textového editoru a je mo�né s ním pohybovat  po plo�e okna
editoru pomocí kurzorových �ipek. Druhý kurzor ve tvaru bloku se objevuje pouze
na pozicí, kde je mo�né editovat obsah pamìti. Pøesun kurzoru je mo�né provést
té� pomocí my�i umístìním kurzoru my�i na vybranou pozici a stiskem levého
tlaèítka.

l pohyb blokového kurzoru - blokový kurzor je mo�né pøesouvat v�dy na následující
nebo pøedcházející polo�ku pamìti. Není-li kurzor zobrazen, pak se pøesune
na nejbli��í následující èi pøedcházející polo�ku vzhledem ke kurzoru
standardnímu. Pøemístìní blokového kurzoru na následující polo�ku je mo�né
pomocí klávesy Tab nebo stiskem kombinace kláves Ctrl→. Pøedcházející polo�ku

Editor datové pamìti Editor programové pamìti
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vyhledáme pomocí kombinace kláves Ctrl←. Na první polo�ku editoru pamìti
pøemístíme kurzor pomocí kláves Ctrl-PgUp, na poslední pomocí kombinace
Ctrl-PgDn. První polo�ku na øádku zvolíme klávesou Home, poslední klávesou
End.

l funkce pro body zastavení a body trasování - tyto funkce umo�òují zadat
a zobrazit adresový bod zastavení (Address Break) a zobrazit bod trasování. Bod
trasování je zobrazen zvýraznìním prvního znaku polo�ky, bod zastavení
zvýraznìnou barvou polo�ky.

l editace pamì�ového místa a funkce automatického posunu - editor umo�òuje
editovat zvolenou polo�ku pouze pomocí platných znakù ve zvolené èíselné
soustavì zobrazení, tj. v binární soustavì jsou povoleny znaky 1 a 0, v dekadické
od 0 do 9 atd. Funkce automatického posunu kurzoru spoèívá v tom, �e po editaci
posledního znaku polo�ky pøejde kurzor automaticky na polo�ku následující.

3.6 Zpìtný pøekladaè (Disassembler)
Zpìtný pøekladaè je urèen pro zobrazení obsahu programové pamìti emulovaného

mikropoèítaèe vèetnì jeho zpìtného pøevodu do mnemoniky instrukcí. Výpis je
uspoøádán do dvou sloupcù, pøièem� v prvním sloupci je hexadecimálnì uvedena adresa
pamìti a v druhém sloupci je uvedena instrukce, kterou reprezentuje pøíslu�ný operaèní
kód ulo�ený v pamìti.

Ovládání zpìtného pøekladaèe je následující:

l pohyb kurzoru - pohyb kurzoru v oknì zpìtného pøekladaèe je umo�nìn pomocí
kurzorových kláves nebo my�i zcela analogicky k editoru zdrojového textu
èi editoru programové nebo datové pamìti.

l editace a pøeklad - pomocí zpìtného pøekladaèe je mo�né editovat programovou
pamì� pomocí mnemoniky instrukcí. Pøi editaci umístíme kurzor na po�adovanou
adresu a stiskneme klávesu Enter. Po stisku klávesy se otevøe dialogové okno
øádkového pøekladaèe. Pomocí dvou polí zadáme adresu (pøípadnì ponecháme
adresu beze zmìny) a zapí�eme instrukci platnou mnemonikou. Stiskneme tlaèítko
OK v dialogovém oknì a pokud bylo mo�né zápis vyhodnotit a pøelo�it, pak je
obsah programové pamìti modifikován. Pøípadná chyba v zápisu je oznámena
pomocí chybového hlá�ení do dialogového okna chyb a obsah pamìti se nezmìní.

l funkce zobrazení bodù zastavení a trasování - body zastavení jsou pøekladaèem
zobrazovány pomocí zvýraznìného øádku. Body trasování jsou oznaèovány
znakem ² .

l funkce zobrazení èítaèe instrukcí - v prùbìhu emulace prochází mikrokontrolér
aplikaèní program podle zadaných instrukcí, pøièem� se mìní hodnota
programového èítaèe. Zpìtný pøekladaè zobrazuje hodnotu programového èítaèe
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pomocí barevného podsvícení instrukce, její� umístìní v programové pamìti
odpovídá aktuální hodnotì programového èítaèe.

l funkce zvýraznìní syntaxe (Highlight) - funkce se volí globálnì pro v�echny
objekty integrovaného prostøedí v u�ivatelském nastavení, a tudí� na ni reaguje
i zpìtný pøekladaè. Tato funkce barevnì odli�uje významy klíèových slov a znakù.

3.7 Výpis trasovací pamìti (Trace Buffer)
Do trasovací pamìti se v prùbìhu ladìní programu ukládají informace o bìhu

programu. Ukládat je mo�né buï v�echny kroky, kterými program procházel, nebo
pouze vybrané pasá�e programu (podmínìné trasování). Výpis trasovací pamìti je
uspoøádán po jednotlivých adresách a je vypisován tak, �e spodní øádek výpisu odpovídá
nejbli��í minulosti a vrchní øádek výpisu odpovídá nejstar�ímu pøíkazu. Výpis je mo�né
u�ivatelsky formátovat do nejvhodnìj�ího tvaru.

3.7.1 Uspoøádání trasovací pamìti

Trasovací pamì� má �íøku slova 32 bitù, které jsou z hlediska záznamu informací
rozdìleny na tøi díly. Do prvních �estnácti bitù se v pøi bìhu programu ukládá hodnota
programového èítaèe spolu s podpùrnými informacemi o spou�tìní a zastavování
trasování. Dal�ích osm bitù pamì�ového slova je urèeno pro ulo�ení výsledkù
z aritmeticko-logické jednotky. Obsah posledních osmi bitù je volitelný. Buï je mo�né
do nich ukládat hodnoty pøesunované po vnitøní datové sbìrnici mikroprocesoru, nebo
vzorky hodnot z osmi externích logických sond. Výpis trasovací pamìti je konstruován

Okno zpìtného pøekladaèe

Okno øádkového pøekladaèe

klávesa Enter
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z tìchto údajù. Ka�dý øádek výpisu je rozdìlen do následujících polí:

l Depth - ukazatel hloubky trasovací pamìti. Jedná se o èíslo se znaménkem mínus
v rozsahu (-1 a� -4096), vyjadøující historii ulo�ených dat.

l Probes - pole pro osm sloupcù pro zobrazení vzorkù logických signálù z externích
sond. V pøípadì, �e je zvoleno trasování interní sbìrnice mikropoèítaèe, jsou
v tìchto sloupcích zobrazována data pøená�ená po interní sbìrnici. Jednotlivé
sloupce je mo�né u�ivatelsky pojmenovat. V pøípadì zobrazení interní sbìrnice
jsou zvoleny inplicitní názvy Bs7 .. Bs0. Jména se zadávají pomocí nastavení
výpisu trasovací pamìti, viz 3.17.

l PC - ve sloupci je zobrazena hodnota programového èítaèe pro aktuální historii
øádku.

l ALU - sloupec zobrazuje výsledky aritmeticko-logické jednotky mikropoèítaèe
pro danou historii, tj. pro instrukci vykonanou v daném okam�iku

l Disassembler - sloupec zobrazuje vykonávanou instrukci v dané historii, která je
rekonstruována ze zaznamenané hodnoty programového èítaèe a obsahu
programové pamìti.

Pohyb kurzoru ve výpisu trasovací pamìti je mo�né ovládat kurzorovými klávesami
nebo my�í. Pøesun kurzoru na poèátek øádky lze vyvolat stiskem klávesy Home, pøesun
na konec øádky pomocí klávesy End. Klávesami PgDn a PgUp se kurzor pøemístí na
dal�í stránku. Klávesy Ctrl-PgDn a Ctrl-PgUp pøesunou kurzor na poèátek trasovací
pamìti, tj. k nejmlad�ímu údaji, resp. na konec trasovací pamìti k údaji nejstar�ímu.

3.7.2 Nastavení a volby

Formátování výpisu trasovací pamìti je mo�né u�ivatelsky nastavit pøíkazem
�Option→Trace Memory Setup� hlavního menu. K dispozici jsou volby typu zobrazit
([X]), resp. nezobrazit ([  ]) pro jednotlivé sloupce pole Probes, sloupec ALU a sloupec
Disassembler. U osmice sloupcù �Probes� je mo�né volit pro ka�dý zobrazovaný
sloupec tøípísmenné jméno, vybírat separátnì zobrazení sloupce, a volit mezi èíselným
nebo semigrafickým zobrazením.
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3.8 U�ivatelské výpisy promìnných (Watch)
Editor u�ivatelského výpisu promìnných (Watch) je urèen pøedev�ím k formátování

výpisu obsahu jednotlivých registrù emulovaného mikropoèítaèe na obrazovku. Editor
umo�òuje snadnou modifikaci obsahu registrù a zobrazení a modifikaci i registrù
procesoru, které nejsou pøístupné v jeho datové pamìti. Editor u�ivatelských výstupù
umo�òuje zobrazit maximálnì 256 údajù. Vy��í poèet zobrazovaných údajù by v oknì
pùsobil nepøehlednì. Aby i pøesto bylo mo�né sledovat vìt�í poèet promìnných, je
umo�nìno souèasnì otevøít více editorù. Jejich poèet není programovì nijak omezen.
Jediné omezení je dáno dostatkem operaèní pamìti osobního poèítaèe.

l pohyb kurzoru - barevnì odli�ené podsvícení vybraného údaje a souèasnì teèka
v prvním sloupci pøedstavuje kurzor v editoru výpisù. K pohybu v oknì je mo�né
pou�ít klávesy kurzorových �ipek nebo my�. Dále je mo�né vyu�ít kláves PgDn
a PgUp pro stránkování, pøípadnì kláves Ctrl-PgUp a Ctrl-PgDn pro pøemístìní
kurzoru na první resp. poslední záznam editoru.

l formát výpisu - ka�dá zobrazovaná promìnná je vypisována v pøedem
definovaném formátu, který je èásteènì pevný a èásteènì volitelný. Implicitní
výpis se týká prvních dvou údajù. První údaj oznamuje typ pamìti èi registru,
a mù�e nabývat hodnot Virtual, Data a Address. Pojmem Virtual oznaèujeme
registry, které nejsou obecnì dostupné v datové pamìti, napø. støadaè WREG
(oznaèení støadaèe je zvoleno odli�nì z dùvodu kolize pøi zápisu cílového registru
výstupu operace v instrukci - bit destination mù�e být buï W a nebo F). Pojmem
Data jsou oznaèeny registry èi promìnné umístìné v programovì pøístupné pamìti
dat. Dal�í sloupec výpisu obsahuje údaj o typu promìnné. V tomto slouci se
mù�e objevit jedno ze ètyø oznaèení:

n B (byte) - oznaèení osmibitové promìnné (bajtu), registru

n b (bit) - oznaèení pro jednotlivý bit

n BA (byte array) - oznaèení pro pole osmibitových registrù (bajtù)

n bA (bit array) - oznaèení pro pole bitù

Typ pamìti

Typ promìnné

Jméno promìnné

Hodnota
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Bli��í význam typù promìnných je mo�né nalézt v kapitole 4.4.2 vìnované
roz�íøeným datovým typùm.

Posledním identifikaèním pojmem je Address tj. oznaèení, �e se jedná o zobrazení
adresy, na které je promìnná v pamìti alokována.

Dal�ím údajem na øádce je jméno promìnné èi registru. V pøípadì, �e se na øádku
zobrazuje adresa registru, pøedchází jeho jménu znak @. Posledním údajem je hodnota
registru (adresy) v emulaèní pamìti mikroprocesoru. Hodnota mù�e být zobrazována
celkem ve ètyøech èíselných soustavách, tj. v hexadecimální, decimální, oktalové,
binární, nebo jako znaky ASCII. Zobrazení adresy je v�dy hexadecimální. U adresy
bitových promìnných je za èárkou doplnìno k adrese i poøadí bitu z rozsahu 0..7.
Jedná-li se o pole bitù, pak jsou bity èíslovány od poèáteèního smìrem k vy��ím øádùm
dvojkové soustavy a k vy��ím adresám bajtù.

3.8.1 Formátování a editace hodnoty

Pøidání promìnné do výpisu je mo�né provést buï pøíkazem �Debug→Add Watch�
z hlavního menu nebo stiskem klávesy Ins. Reakce editoru pak závisí na poloze kurzoru.
Pokud umístíme kurzor nakonec seznamu, je promìnná pøidána. Umístìním kurzoru
na polo�ku, která ji� existuje, mù�eme novou polo�ku do seznamu vlo�it. Editace
hodnoty je vyvolána na kurzorem vybrané polo�ce a stiskem klávesy Enter.

Pøidání promìnné

Editace hodnoty
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3.9 Výpis a editace zásobníku
Výpis obsahu zásobníku je kostruován podle ulo�ených návratových adres a

aktuální hodnoty ukazatele zásobníku. Návratové adresy a hodnotu ukazatele zásobníku
je mo�né editovat pomocí pøíkazù:

l New Stack - spustí editor polo�ky zásobníku

l New SP - spustí editor ukazatele zásobníku

Tyto pøíkazy vyvoláme pomocí menu a nebo stiskem klávesy Enter na pøíslu�né
polo�ce zobrazení.

3.9.1 Editor polo�ky zásobníku

Jedná je o prostý øádkový editor vybavený objektem zobrazení dostupných
symbolù. V tomto zobrazení jsou uvedeny symboly návì�tí a konstant zji�tìných
v prùbìhu pøekladu. Návratovou adresu je mo�né zadat pomocí symbolu (návì�tí)
nebo pomocí èíselného zápisu, který je mo�né vyhodnotit.

3.9.2 Editor ukazatele zásobníku

Editor je urèen k modifikaci aktuální hodnoty ukazatele zásobníku. Hodnota se
zadá pomocí èíselného zápisu a nebo pomocí výrazu, který je mo�né v aktuálním
stavu vyhodnotit.

Zobrazení obsahu zásobníku

Editor polo�ky zásobníku

Editor ukazatele zásobníku
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3.10 Výpisy a editace událostí
Mezi události poèítáme obecnì body zastavení bìhu programu (Breakpoints) a

body trasování programu (Trace Points). Pomocí editoru událostí je mo�né zadat a�
256 odli�ných záznamù, které urèují podmínky zastavení èi trasování programu aplikace.
Pro zobrazení a editaci slou�í editor bodù zastavení (Breaks).

3.10.1 Výpisy událostí

l pohyb kurzoru - kurzor v uvedeném editoru výpisù pøedstavuje barevnì odli�ené
podsvícení vybraného údaje a souèasnì teèku v prvním sloupci výpisu. K pohybu
v oknì je mo�né pou�ít klávesy kurzorových �ipek nebo my�. Dále pak je mo�né
vyu�ít kláves PgDn a PgUp pro stránkování, pøípadnì kláves Ctrl-PgUp a
Ctrl-PgDn pro pøemístìní kurzoru na první resp. poslední záznam editoru.

l formát výpisu - ka�dá zobrazovaná událost je vypisována v implicitním formátu.
Výpis se skládá ze sloupce pro lokální povolení èi zakázání aktivity události,
sloupce s výpisem alokace události, sloupce s výpisem definice úèinku události,
jména události a adresového rozsahu události.

l povolení/zákaz události - povolení nebo zákaz aktivity události je naznaèen jedním
z následujících výpisù:

[ ] - aktivita události je potlaèena

[x] - aktivita události je lokálnì povolena, ale její aktivita je potlaèena
globálnì, tj. událost není aktivní

[X] - aktivita události je povolena lokálnì i globálnì, a tudí� je událost aktivní

l alokace události - sloupec udává pamì�ový prostor, do nìho� je událost svojí
definicí alokována. Alokace události mù�e být dvojího typu:

n Code - bod zastavení na adrese èi rozsahu adres programové pamìti.

n Data - bod zastavení na adrese èi rozsahu adres datové pamìti

l typ události - sloupec udává typ události, pro nìj� je záznam definován. Události
mohou nabývat následujících typù:

a) pro alokaci typu Code

m Address - bod zastavení programu na adrese èi v rozsahu adres programové
pamìti (prostý adresový break s mo�ností volit rozsah)

m Trace - bod trasování (prùbìh programu bude ukládán v zadaném rozsahu
adres)
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b) pro alokaci typu Data

m Access - bìh programu bude zastaven pøi pøístupu na registr zadané adresy
èi rozsahu adres (pøístupem je mínìno ètení nebo zápis libovolné hodnoty)

m Write - bìh programu bude zastaven pøi zápisu libovolné hodnoty do registru
na dané adrese nebo v zadaném rozsahu adres

m Value - bìh programu bude zastaven v pøípadì, �e v dojde k zápisu na
zadanou adresu (rozsah adres) a souèasnì zapisovaná data vyhovují zadané
hodnotì vèetnì bitové masky. Emulátor umo�òuje zadat jednu hodnotu a
jednu masku spoleènou pro v�echny události tohoto typu. Maska a hodnota
jsou implementovány operací AND, tj. z hodnoty jsou platné pouze bity,
jejich� pozice odpovídá jednièkovým bitùm v masce. Ostatní bity zadané
hodnoty jsou ignorovány, tj. na jejich hodnotì nezále�í. Zadáme-li napø.
hodnotu 0xFF a masku 0x1, a implementujeme-li na registr STATUS bod
zastavení typu Value, pak dojde k zastavení v�dy v okam�iku, kdy je carry
bit (C) nastaven zápisem na hodnotu 1.

V rámci typu alokace je mo�né typy událostí sdru�ovat, co� se ve výpisu projeví
spojením událostí pomocí znaku &. Znak & je mínìn ve významu aktivity události,
tj. napø. událost je na adrese aktivní ve funkci bodu zastavení a souèasnì ve funkci
bodu trasování (odpovídající výpis je Code > Address & Trace).

3.10.2 Editace událostí

Pro zadávání a editaci událostí je urèen editor událostí. Je mo�né jej vyvolat pøíkazy
�Debug→Add Break� (Alt-B) hlavního menu nebo stiskem klávesy Ins v oknì výpisu
událostí v pøípadì, �e chceme pøidat definici nové události do seznamu. Editaci události

Body zastavení

Body trasování
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ji� zadané, vyvoláme stiskem klávesy Enter v oknì výpisu událostí. V pøípadì, �e se
kurzor nachází na prázdném øádku výpisu, bude nová událost zadána. Je-li kurzor na
události ji� zadané, bude událost editorem modifikována.

3.11 Globální události
Globální události jsou volby, kterými mù�e u�ivatel ovlivòovat bìh programu a

nastavovat rùzné funkce emulátoru. V nastavení jsou k dispozici nabídky:

l External Breaks - slou�í k povolení zastavení programu externím signálem

m Enable - povolení-zákaz externího signálu zastavení
n L-H edge
n H-L edge   - volba aktivní hrany signálu zastavení

l Internal Breaks - souhrn voleb pro vyvolání zastavení programu nìkterou
z interních událostí emulaèního èipu
m Wdt overflow - zastavení v okam�iku pøeteèení èítaèe "Watch-Dog"
m Trace overflow - zastavení v okam�iku naplnìní trasovací pamìti
m TMR0 overflow - zastavení v okam�iku pøeteèení èasovaèe TMR0. (Pùvodní

název TMR0 je RTCC, pro kompatibilitu se souèasnou dokumentací firmy
Microchip se budeme dr�et nového názvu.)

m Stack overflow/underflow - zastavení v okam�iku pøeteèení nebo podteèení
ukazatele zásobníku
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l Global Enable Breaks - spoleèná aktivace a deaktivace bodù zastavení a trasování
m Code Breaks - povolení/zákaz v�ech bodù zastavení v programové pamìti
m Data Breaks - povolení/zákaz v�ech bodù zastavení v datové pamìti
m Trace All - povolení/zákaz podmínìného trasování (je-li podmínìné trasování

zakázáno, trasují se v�echny instrukce)

l Value of Ram Breaks, Value Mask - editor hodnoty a masky pro body zastavení
v datové pamìti podle hodnoty a masky (hodnotu a masku je mo�né zadat
dekadicky nebo hexadecimálnì v konvenci jazyka C, tj. 0x10 apod)

Tlaèítko OK potvrzuje nastavení. Tlaèítko Cancel zpùsobí ignorování zmìn v
nastavení.

3.12 Nastavení emulátoru
Volby Nastavení Emulátoru slou�í k základní konfiguraci emulaèního èipu a

tomu odpovídajícímu nastavení integrovaného prostøedí.

l Processors - nastavení typu emulovaného procesoru

l Clock Source - volba zdroje hodinového signálu pro emulovaný procesor.

m Internal - spou�tí interní zdroj hodin. V tomto pøípadì je hodinová frekvence
nastavena parametrem Clock.

m External - zdroj hodinového signálu pro emulaèní èip je získáván z aplikace
prostøednictvím hodinového vstupu procesoru

Default: Internal

Poznámky, doporuèení:

1. Externí zdroj hodin pou�ívejte výhradnì v pøípadech, kdy je z hlediska aplikace
naprosto nezbytný. Z dùvodu rychlosti odezvy systému pou�ívejte externí zdroj
hodin s kmitoètem alespoò 25kHz. Naprostá vìt�ina interních operací  emulaèního
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èipu je toti� synchronní s hodinami emulovaného procesoru, a k provedení
potøebuje nìkolik taktù hodin.

2. V pøípadì volby Internal je vstup OSC1/CLKIN emulovaného procesoru
ignorován, v pøípadì volby External se na tento vstup pøivádí aktivní hodiny
z externího zdroje. V obou pøípadech se tedy ignorují jakékoli pøipojené krystaly,
keramické rezonátory nebo RC èleny.

l MCLR Enable - povolení resetu emulaèního èipu z pinu -MCLR

emulovaného procesoru nebo pøi poklesu napájecího napìtí emulovaného
procesoru pod hodnotu asi 2.5 V.

Default: Disabled

l Clock - nastavení hodinového kmitoètu pro interní zdroj hodin. Kmitoèet lze
nastavit v rozsahu od 25kHz do 20MHz, resp. do maximálního povoleného
kmitoètu emulovaného procesoru. Zadaná hodnota se zaokrouhlí na nejbli��í
hodnotu, kterou je interní frekvenèní syntezátor schopen vygenerovat (krok  40Hz).
Maximální odchylka, zpùsobená tímto zaokrouhlením, je tedy pro minimální
povolenou frekvenci 25 kHz men�í ne� 0.1%, a pro vy��í kmitoèty dále úmìrnì
klesá a stává se zanedbatelnou proti vlastní pøesnosti pou�itého krystalového
oscilátoru. Zobrazovaná hodnota je v�dy zadaná hodnota (nezaokrouhlená).

l Background Debug Mode

m Enable - vyèítání a editace datové pamìti emulátoru v reálném èase, tj. za pl-
ného bìhu programu v emulaèním èipu.

m Disable - vyèítání a editace datové pamìti emulátoru pouze ve stavu Halted.

Pozn.: V re�imu Background Debug Mode je umo�nìno editovat datovou pamì�
mikropoèítaèe. Pøi editaci je v�ak nutné si uvìdomit, �e emulaèní èip bì�í oproti editaci
mnohonásobnì rychleji, a tudí� editace mù�e pøi nesprávném pou�ití zhroutit aplikaèní
program. V tomto re�imu se té� provádí automaticky cyklické vyèítání datové pamìti.

l Hw Driver - stisknutím tlaèítka se vyvolá okno s popisem hardwarového ovladaèe
emulátoru. V tomto popisu jsou uvedeny vlastnosti ovladaèe a pøípadná omezení
v emulaci zvoleného typu procesoru.
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Tlaèítko OK potvrzuje nastavení. Tlaèítko Cancel zpùsobí ignorování zmìn
v nastavení.

3.13 Chip options
je dialog, kterým se nastavují speciální funkce emulovaných èipù. Obsah dialogu

se mìní podle aktuálnì nastaveného procesoru. Uveïme alespoò nejèastìj�í polo�ky
dialogu.

l Watch Dog

m Wdt Enable - povolení èinnosti èítaèe Watchdog timer (WDT). I v pøípadì, �e
je WDT povolen, je mo�né program krokovat, ani� by to naru�ilo jeho funkci,
proto�e WDT je v re�imu krokování mezi jednotlivými kroky pozastavován.
Default: Disabled

m Min, Typ, Max - trojice voleb pro nastavení doby pøeteèení WDT (volby najdou
uplatnìní pøi toleranèní analýze programu, v nìm� je WDT vyu�it). Hodnoty
jsou nastaveny na základì katalogových údajù výrobce pro daný typ procesoru,
napø. pro PIC16C5x na 9, 18 a 30 ms.

Default: Typical

l Clock Mode - nastavení re�imu výstupu OSC2/CLKOUT

m Xtal - na výstupu CLKOUT je kmitoèet zadaný volbou Clock.
m RC mode - na výstupu CLKOUT je k dispozici ètvrtinový kmitoèet tak, jak to

odpovídá specifikaci emulovaných procesorù s oscilátorem RC.

Default: Xtal

l On Chip Reset

m Power Up Timer - zapnutí èasovaèe pro Power Up Reset.

m Ost Start Up Timer - zapnutí èasovaèe �Start Up Timer�.
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3.14 Nastavení parametrù pøekladaèe
Toto nastavení ovlivòuje bìh integrovaného pøekladaèe. Jedná se zde pøedev�ím

o u�ivatelské volby pro formátování výstupních souborù.

l Output Options

m Output HEX File - generování výstupního souboru ve formátu Intel Hex

n INH-16 - výstupní soubor bude ulo�en ve formátu Intel Hex-16.

n INH-8M - výstupní soubor bude ulo�en ve formátu Intel Hex-8M.

l Output Listing - povolení generování výstupního souboru s textovým protokolem
o pøekladu

m Include Symbols - ve výpisu bude/nebude uveden seznam symbolù.

m Include Device Map - ve výpisu bude/nebude uvedeno pouzdro procesoru,
pro který byl proveden pøeklad.

m Wrap Lines - pøekladaè bude zalamovat øádky v pøípadì, �e budou po pøekladu
pøesahovat 80 znakù.

m Lines Per Page - nastavení poètu øádek na jednu stránku výpisu.

l Default Radix - nastavení základní èíselné soustavy, v ní� pøekladaè interpretuje
zadávané èíslice bez uvedené specifikace soustavy

m Decimal - v�echna èísla, u nich� není spacifikována soustava, budou
interpretována jako dekadická.

m Hexadecimal - v�echna èísla, u nich� není spacifikována soustava, budou
interpretována jako hexadecimální.
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l Case Sensitivity - pøekladaè bude rozli�ovat velká a malá písmena u:

m Symbols - symbolù, tj. jmen promìnných, návì�tí, atd..

m Opcode - u mnemoniky instrukcí.

m Directive - u direktiv pøekladaèe.

Tlaèítko OK potvrzuje nastavení. Tlaèítko Cancel zpùsobí ignorování zmìn
provedených v nastavení.

Poznámky:

a) Mnemonika instrukcí pro rozli�ování velkých a malých písmen se zapisuje v�dy
s prvním písmenem velkým. Ostatní písmena jsou malá. Toté� platí i pro direktivy
pøekladaèe. U symbolù jsou písmena rozli�ena podle prvního zápisu symbolu
ve zdrojovém textu.

b) Parametrem pøekladaèe je té� typ procesoru, pro který je pøeklad provádìn. Tento
parametr je pøekladaèi pøedáván z nastavení emulátoru.

3.15 Nastavení parametrù prostøedí
Nastavení parametrù prostøedí slou�í k u�ivatelské konfiguraci vzhledu obrazovky

a chování systému v urèitých specifických stavech. Nastavení se ukládá v�dy
s projektem (je-li otevøen) nebo do souboru DPIC.PRJ v pracovním adresáøi.

l Screen Size

m 25 , 40/50 lines - nastavení poètu øádkù na obrazovce.

l Editor - nastavení parametrù editoru zdrojového textu, s nimi� bude editor
spou�tìn.

m Auto Indent - automatické odsazování zaèátku textu podle pøedchozího øádku.

m OverWrite - zapnutí re�imu pøepisování.

m Load Object - v pøípadì, �e nebude otevøen �ádný projekt, pokusí se prostøedí
nalézt a nainstalovat do emulaèní pamìti pøelo�ený �object soubor� podle
jména otevíraného souboru.

l Auto Save

m Source File - v�echny zdrojové soubory budou automaticky ulo�eny pøi
ukonèení práce v integrovaném prostøedí.

m Desktop File - automaticky bude ulo�eno nastavení prostøedí vèetnì rozmístìní
oken na pracovní plo�e.

l Line Highlight - v�echny typy editorù budou zobrazovat jednotlivé skupiny
symbolù a znaèek zdrojového textu pøidìlenými barvami (jedná se té�
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o jednoduchou syntaktickou kontrolu pro mnemoniku instrukcí, známých operandù
apod.)

l Source File Extension - tøípísmenná extenze pro soubory obsahující zdrojový
text

l Disassembler Extension - tøípísmenná extenze pro ukládání souborù
s disasemblovanými soubory

Tlaèítko OK potvrzuje nastavení. Tlaèítko Cancel zpùsobí ignorování provedených
zmìn.

3.16 Nastavení parametrù výpisu pamìtí
 Pøíkazem �Option→Data Memory Setup� se vyvolá okno Data Selectoru, kde

zvolíme registrovou banku a po stisku klávesy Enter  se vyvolá okno editoru nastavení
výpisu datové pamìti. Nastavení výpisu programové pamìti se vyvolá obdobnì
pøíkazem �Option→Program Memory Setup�.

3.16.1 Data Selector

Okno Data Selectoru je tvoøeno seznamem
Data Area, který je vybaven vertikální rolovací li�tou
a kurzorem. Pomocí kurzoru zvolíme banku (oblast)
datové pamì�i a stiskem klávesy Enter vyvoláme
editor pro nastavení obsahu pamìti. Tlaèítkem
Cancel mù�eme volbu zru�it a uzavøít okno Data
Selectoru.
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3.16.2 Editor nastavení výpisu

Editorem nastavení výpisu mù�eme výpis formátovat následujícími parametry:

l Digit(s) - øádkový editor pro nastavení poètu èíslic pro výpis jedné pamì�ové
buòky. Povolený rozsah je od 1 do 16. Je-li zvolený poèet míst men�í ne� potøebný,
pak bude èíslo oøíznuto zleva tj. od vy��ích øádù. V pøípadì, �e zadaný rozsah
bude vìt�í, ne� je potøebný poèet èíslic, dojde ve výpisu k pøedsazení nul, tak aby
byl po�adovaný poèet èíslic dodr�en.

l Label - nastavení poètu míst pro zobrazení adresy. Povolený rozsah je 1 a� 8.
Adresa je zobrazována v hexadecimální soustavì s pøípadnými pøedøazenými
nulami.

l Columns - nastavení poètu sloupcù výpisu v rozsahu 1-5

l Radix - nastavení po�adované soustavy pro výpis obsahu pamìti (v takto zvolené
soustavì bude pracovat i pøíslu�ný editor výpisu).

Tlaèítko OK potvrzuje nastavení. Tlaèítko Cancel zpùsobí ignorování provedených
zmìn.

3.17 Nastavení výpisu trasovací pamìti
l Probe Selector

m Probe - umo�òuje zadat pro ka�dý vypisovaný signál sond tøípísmenný název.

m Selector - umo�òuje vybrat sondu, která bude ve výpisu zobrazována.

l Probe As.. - pøepínaè typu zobrazení sond dává volbu mezi semigrafickým a
èíselným zobrazením logické hodnoty.

l Optional View - pøepínaè mezi interními a externími sondami. Interní sondy jsou
v�dy zapojeny na interní datovou sbìrnici procesoru v cyklu Q1. Pro instrukce
pracující s File Registry se zde objevuje vstupní hodnota registru, pro instrukce
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s literály je zde kopie literálu. Externí sondy jsou vyvedeny na konektor, a je
mo�né je zapojit  libovolnì do aplikace v  rozsahu napájecího napìtí emulovaného
procesoru. Rozhodovací úroveò je pøibli�nì 1.6V. Do trasovací pamìti se zapisuje
jejich stav na konci cyklu Q1, tedy ve stejném okam�iku, kdy se ète stav pinù
procesoru.

l Enable View - povolení zobrazení jednotlivých blokù trasovací pamìti v oknì.

m ALU - zobrazení výstupu aritmeticko-logické jednotky.

m Dasm - zobrazení disasemblovaného programu.

m Optional - zobrazení nastaveného typu sond, tj. buï externí nebo interní, podle
nastavení v Option a View.

Tlaèítko OK potvrzuje nastavení. Tlaèítko Cancel zpùsobí ignorování provedených
zmìn.

3.18 Nastavení barev prostøedí
Tato volba umo�òuje u�ivateli nastavit barvy jednotlivých objektù na obrazovce

spolu s dal�ími parametry zobrazení. Okno nastavení je rozdìleno do blokù:

l Group - seznam umo�òující volbu hlavní skupiny objektù

l Item - seznam pro volbu podskupiny objektù ze skupiny Group

l Foreground - nastavení barvy textu pro zvolený objekt

l Background - nastavení barvy podkladu pro text zvoleného objektu

m Blink - nastavení atributu blikání pro text zvoleného objektu

l Desktop Pattern - nastavení vzorku pracovní plochy

Pozn.: Volba vzorku pracovní plochy (Desktop pattern) umo�òuje volbu znaku,
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který bude zobrazován na pracovní plo�e. Vybereme-li v dialogovém oknì toto
nastavení, pak pomocí stisku �ipky dolù vyvoláme okno se zobrazením roz�íøených
ASCII znakù. Kurzorem zvolíme po�adovaný znak a stiskneme klávesu Enter. Znak
je po uzavøení dialogového okna pro nastavení barev zaveden na pracovní plochu a
vytvoøí tak podklad.

3.19 Pomocné objekty na pracovní plo�e
Pracovní plocha je mimo menu tvoøena je�tì pomocnými objekty zobrazení,

udávajícími informace o integrovaném prostøedí a o emulaèním systému.

3.19.1 Status

Status je umístìn na horní li�tì spoleènì s hlavním menu. Slou�í k zobrazení stavu
emulátoru, hodnoty programového èítaèe (pokud je známa) a typu emulovaného
procesoru. Jednotlivé stavy emulátoru jsou:

l Undefined - neznámý stav v prùbìhu spou�tìní prostøedí, kdy je�tì není kontakt
s emulátorem, nebo poskytl-li emulátor nìjaká neznámá data pøi komunikaci.

l Error - stav, který nastane v okam�iku zji�tìní nìjaké chyby v komunikaci
s emulátorem nebo pøi po�adavku od u�ivatele, který se nepodaøilo splnit. Napø.
verifikace obsahu pamìti programu nebyla úspì�ná.

l Running - oznaèuje reálný bìh emulátoru.

l Halted - emulátor je zastaven.

l Break - emulátor zastavil pøi splnìní podmínky zastavení.
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l Step - je vykonáván programový krok

l Download - probíhá konfigurace emulátoru

l Load - probíhá naèítání pøelo�eného kódu do emulaèní pamìti

l Verify - probíhá verifikace kódu z emulaèní pamìti

l Busy - emulátor je zaneprázdnìn a èeká se na dokonèení zadané operace

3.19.2 Programový mana�er

Zobrazení stavu programového mana�eru je umístìno uprostøed spodní li�ty
pracovní plochy. Zobrazení má dvì èásti. Nalevo od dìlící èáry se zobrazuje jméno
projektu a napravo jméno objektového souboru, který je aktuálnì pøítomen v emulaèní
pamìti. Není-li otevøen projekt nebo objekt, zobrazuje se v pøíslu�ném poli stav "None".

3.19.3 Indikátor dostupné pamìti

V pravém dolním rohu je zobrazována velikost dostupné pamìti pro integrované
prostøedí. Hodnota je uvedena v bajtech.

3.20 Okno chybových hlá�ení pøekladaèe
Okno chybových hlá�ení pøekladaèe je objekt pro usnadnìní hledání øádkù

s chybami vyhodnocenými pøekladaèem. Okno je automaticky otevøeno pøi nalezení
jakékoliv chyby ve zdrojovém textu v libovolné fázi pøekladu. Po otevøení okna jsou
chyby zobrazeny ve formátu:

 èíslo øádky, soubor, typ chyby

Stisknutím klávesy Enter je ve zdrojovém textu nalistován øádek, kde byla chyba
nalezena, a souèasnì je editor zdrojového textu aktivován. Hledání dal�ích chyb je
mo�né pomocí kláves Alt-F8 pro pøechod k následující chybì a Alt-F7 pro pøechod
k pøedcházející chybì. V pøípadì, �e se pøeklad skládá z více souborù zdrojového
textu a chyby jsou alespoò ve dvou z nich, je mo�né stiskem klávesy mezerníku zvolenou
chybu vybrat a oznaèit. Listování chyb pak bude probíhat pouze v souboru, jeho�
chyby byly takto oznaèeny.
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Ve zdrojovém textu je mo�né nalezenou chybu ihned opravovat, ani� by se ztratily
odkazy na chyby dal�í. Pokud øádek s chybou vyma�eme, dojde k vymazání pøíslu�né
chyby z výpisu chyb.

V prùbìhu pøekladu mù�e dojít k nalezení nesrovnalostí èi jiných problémù, které
vy�adují vydat u�ivateli upozornìní. V tìchto pøípadech není okno chyb otevøeno
automaticky. Pokud ho chceme otevøít, stiskneme v editoru zdrojového textu kombinaci
kláves Alt-A.

3.21 ASCII tabulka
Pomocí pøíkazu  �≡→ASCII� je mo�né

otevøít okno se zobrazením ASCII tabulky.
Ve spodní èásti okna je umístìna li�ta,
na ní� je zobrazen znak vybraný kurzorem
spoleènì s jeho èíselnou reprezentací v deka-
dické a hexadecimální soustavì.

3.22 Calculator
Pomocí pøíkazu �≡→Calculator� vyvoláme okno s jednoduchým kalkulátorem

zpracovávající celá èísla v rozsahu -32768 a� 32767. Kalkulátor pracuje v dekadické,
hexadecimální a binární èíselné soustavì.

Umo�òuje operace:

mazání chyby - klávesa S
zmìna znaménka - klávesa _
druhý doplnìk - klávesa ^
sèítání - klávesa +
odèítání - klávesa -
celoèíselné dìlení - klávesa /
zbytek po dìlení - klávesa M
násobení - klávesa *
provedení výpoètu - klávesa Enter
dekadická soustava - klávesa .
hexadecimální soustava - klávesa H
binární soustava - klávesa %

Klávesami odpovídajícími ostatním tlaèítkùm se zadávají èíselné operandy výpoètù
s tím, �e pro binární soustavu mají význam pouze tlaèítka 1 a 0, pro dekadickou tlaèítka
0 a� 9, a pro hexadecimální tlaèítka 0 a� 9 a A a� F.
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3.23 Videostop
Nefunguje-li emulovaná aplikace,

videostop Vás spolehlivì dorazí. Videostop
je jednoduchá hra pro chvíle oddechu. Cílem
je po spu�tìní pomocí tlaèítka Go zastavit
pøeklápìní kostek v okam�iku, kdy jsou
èíslice alespoò na dvou kostkách stejné.
K dispozici je pøi jedné høe deset pokusù.
Za ka�ký úspì�ný pokus je zapoèítáno 10
bodù. Pøi neúspì�ném pokusu je deset bodù
odeèteno. Podaøí-li se zastavit kostky
v okam�iku, kdy v�echny tøi zobrazují stejné
èíslo, je pøidìlena prémie 100 bodù. Pomocí
rolovací li�ty je mo�né nastavit rychlost
pøeklápìní kostek. Pomocí prvního stisku tlaèítka Go jsou odkryty kostky. Druhým
stiskem tého� tlaèítka spustíme pøeklápìní kostek. Tlaèítkem Stop zadáváme okam�ik
pro zastavení kostek. Tlaèítko New umo�òuje nastavit hru do poèáteèního stavu.
Tlaèítkem Close se ukonèí hra a okno Videostopu je uzavøeno.

3.24 Information
Okno Information podává nejzákladnìj�í informace o verzi hardware a software.

3.25 Chybová hlá�ení integrovaného prostøedí
Symbol not exist

Zadaný symbol je neznámý, a tudí� nepøístupný. Chyba mù�e být zpùsobena
pøeklepem a nebo tím, �e zadání nepøedcházela úspì�ná kompilace zdrojového
textu.

Syntax error
Ve výrazu byla nalezena chyba, a výraz nelze vyhodnotit. Chyba mù�e být
zpùsobena pøeklepem ve jménu symbolu, chybným zápisem závorek u prvku
polí, neznámým operandem apod.

Out of symbol range
Byl pøekroèen poèet symbolù zobrazitelných oknem Watch. Chybu odstraníme
otevøením dal�ího okna a zadáním po�adovaného symbolu v nìm.

Not accessible symbol
Zadaný symbol není dostupný z dùvodu neúplné definice. Chyba vzniká napø. pøi
editaci konstanty apod.
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Insufficient memory
Nepodaøilo se zaalokovat po�adovaný blok pamìti. Chyba vzniká pøi alokaci
pracovních pamì�ových struktur.

Error of breakpoint type
Byl nalezen chybný typ bodu zastavení nebo trasování. Chyba vznikla v prùbìhu
definice události.

Out of break memory
Byl pøekroèen pøípustný poèet (256) definic událostí. Chybu mù�eme èásteènì
eliminovat pou�itím vìt�ího rozsahu adres v definicích událostí.

Not accessible break(s)
Bod zastavení není dosa�itelný. Napø. rozsah je mimo pøípustnou oblast pamìti
emulovaného procesoru.

Break out of range
Definice události obsahuje polo�ku, která èiní událost hardwarovì nedostupnou.
Pøevá�nì se jedná o pøekroèení pamì�ového rozsahu pro nastavený typ procesoru.

Unable to edit address
Pokus o editaci na adrese, kde to není v daném okam�iku a za daných nastavení
systému mo�né.

Value has been unchanged
Pøi pokusu o zápis do emulaèní pamìti se nepodaøilo hodnotu pamì�ové buòky
zmìnit.

Access denied
Po�adovaná akce byla odmítnuta hardwarem nebo firmwarem emulátoru.

Disk Full
Kapacita disku byla vyèerpána, a ulo�ení souboru nebylo korektnì dokonèeno.

Unable to open *.DEF file
Nebylo mo�né otevøít definièní soubor procesoru. Na chybu prostøedí reaguje
nastavením implicitních hodnot. Chybu odstraníme zpøístupnìním definièního
souboru pro ètení.

*.DEF file read error
Nastala chyba ètení definièního souboru. Soubor je po�kozen. Chybu opravíme
pøeinstalováním souboru z instalaèních disket.

*.DEF file not found
Definièní soubor procesoru nebyl nalezen v domovském adresáøi integrovaného
prostøedí.

Could not open project file
Soubor s definicí projektu není mo�né otevøít. Soubor nebyl nalezen nebo vznikla
chyba ètení.
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Could not create project file
Nebylo mo�né vytvoøit soubor projektu. Chyba vznikla buï nedostatkem místa
na disku, nebo interní chybou v prostøedí.

Project not opened
Pokus o uzavøení projektu, ani� by byl nìjaký otevøen.

Unable to load object file
Soubor objektu nebyl nalezen, nebo nastala chyba ètení.

Can not compile this line
Øádkový pøekladaè není schopen pøelo�it zadaný øádek.

Download file not found
Nebyl nalezen inicializaèní soubor emulátoru. Jedná se o soubory s pøíponou
BIN, které musí být umístìny v domovském adresáøi integrovaného prostøedí.

Download error
Chyba pøi konfiguraci emulátoru. Jedná se o poruchu v hardware, nebo
nekompatibilitu konfiguraèního souboru.

Unable to find help file
Nenalezen soubor nápovìdy. Soubor musí být umístìn v domovském adresáøi
integrovaného prostøedí. Má pøíponu HLP.

Uncompatible project format
Pokus o otevøení projektu, který svojí strukturou neodpovídá formátu projektu
integrovaného prostøedí.

Recompile the program first
Byla nalezena nekonzistence mezi vznikem souboru objektu a zdrojového souboru.
Chybu odstraníme novou kompilací zdrojového textu.

No Line to PC reference exists
Zpracovávaná øádka nemá referenci na adresu v programové pamìti. Chyba mù�e
být zpùsobena pokusem o zadání pøepínacího bodu zastavení po neúspì�ném
pøekladu nebo pokusem zadat bod zastavení na øádek, který nemá reprezentaci
v operaèním kódu, tj. napø kometáøový øádek.

Uncompatible object format
Formát souboru objektu neodpovídá strukturou objektu integrovaného prostøedí.

Unable to Evaluate Expression
Vyhodnocení zadaného výrazu není mo�né z dùvodu nesprávné syntaxe,
neexistence symbolu apod.

Error in Emul Init Procedure
Chyba pøi instalaci ovladaèe emulovaného procesoru. Jedná se o interní chybu,
která mù�e být zpùsobena nekompatibilitou ovladaèe a hardware, vadným
komunikaèním  portem tiskárny, �patným kabelem nebo poruchou emulátoru.
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3.26 Informaèní hlá�ení prostøedí
Save current desktop ? , Save current project ?

Není-li nastaveno automatické ukládání obsahu pracovní plochy po ukonèení práce
s projektem, je u�ivatel po�ádán o potvrzení pokusu ulo�it aktuální nastavení
prostøedí.

Source has been changed - Rebuild ?
Zdrojový text neodpovídá souboru, z nìho� byl vytvoøen pøeklad. Neexistují tedy
reference na øádky, nebo tyto reference neodpovídají aktuálnímu stavu. V pøí-
padì, �e takový zdrojový text nebude zkompilován, pak v prùbìhu krokování
programem nebude ve zdrojovém textu zvýrznìn øádek odpovídající hodnotì
programového èítaèe.

Load object file ?
V pøípadì, �e není otevøen �ádný projekt a u�ivatel zadá pøíkaz k otevøení souboru
s extenzí odpovídající extenzi zdrojového textu v nastavení prostøedí, je po�ádán
o potvrzení zmìny obsahu emulaèní pamìti. Není-li zmìna potvrzena soubor bude
otevøen s tím, �e nebudou naistalovány reference na øádky zdrojového textu se
v�emi dùsledky z toho plynoucími.

Emulator not found. Run Demo ?
V pøípadì, �e nebyla navázána komunikace s emulátorem, je mo�né situaci øe�it
buï potvrzením �ádosti, tj. bude spu�tìn demo simulátor, anebo odmítnutím
�ádosti tj. prostøedí se bude pokou�et znovu navázat kontakt s emulátorem.
V pøípadì, �e emulátor není k dispozici, je mo�né prostøedí spustit pøímo v demo
módu pomocí parametru /DEMO.

Project Exists - Overwrite ?
�ádost o potvrzení akce pøíkazu Save Project as.. v okam�iku, kdy projekt
zadaného jména ji� existuje, a byl by tudí� pøepsán.

PC Overflow
U�ivatel je informován o situaci, kdy do�lo k nekorektnímu pøeteèení èítaèe
instrukcí vlivem chyby v programu vyvíjené aplikace. K situaci dojde v pøípadì,
�e v prùbìhu vykonávání programu je hodnota èítaèe instrukcí zmìnìna z maxima
na nulu, tj. u�ivatelský program "zabloudil". Hlá�ení je mo�né potlaèit pomocí
zákazu této akce v nastavení Global Events.

TMR0 Overflow
Do�lo k pøeteèení èítaèe/èasovaèe. Hlá�ení je mo�né potlaèit pomocí zákazu
v nastavení Global Events.

WatchDog OverFlow
Do�lo k pøeteèení èítaèe Watch Dog s následným resetem procesoru. Hlá�ení je
mo�né zakázat spolu se zákazem zastavení v Global Events.
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Stack Overflow
Do�lo k pøeteèení nebo podteèení zásobníku. K chybì dojde v okam�iku, kdy je
v aplikaèním programu voláno více podprogramù nebo více návratù z podprogramù
ne� dovoluje velikost zásobníku emulovaného procesoru. V aplikaèních
programech v�ak mù�e být pøeteèení nebo podteèení zásobníku zámìrnì
pou�íváno. Pro takové aplikace je mo�nost zastavení a hlá�ení zakázat v nastavení
Global Events. Pro standardní aplikace doporuèujeme hlídání pøeteèení nebo
podteèení zásobníku ponechat zapnutou z dùvodu kontroly vyvíjeného programu
na chyby tohoto typu.

Trace Overflow
Do�lo k zastavení pøi pøeteèení trasovací pamìti. Obsah trasovací pamìti byl
naplnìn a vykonání ka�dé následující instrukce zpùsobí ztrátu jedné polo�ky
historie zaznamenávané do trasovací pamìti. Zastavení a hlá�ení je mo�né potlaèit
nastavením v Global Events.

External Pin Break
Do�lo k zastavení emulátoru z dùvodu detekce hrany na externím u�ivatelském
pinu (sonda Probe0). Hlá�ení je mo�né potlaèit v nastavení Global Events.

External Reset Occured
Pøi bìhu programu do�lo k resetu procesoru z externího zdroje. Externím zdrojem
resetu máme na mysli jakýkoliv reset vyvolaný v emulovaném procesoru jinak
ne� z klávesnice poèítaèe.
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4. Pøekladaè jazyka ASSEMBLER

Tato èást pøíruèky popisuje programovací jazyk assembler pro procesory øad
PIC16C5X a PIC16CXX.

Pøekladaè jazyka je program, který provádí pøeklad zdrojového textu programu
(který je zapsán podle pravidel pøíslu�ného programovacího jazyka) do binárního kódu,
který je mo�né zavést do procesoru a spustit.

Vstupem pøekladaèe je soubor se zdrojovým textem programu (obvykle soubor
s pøíponou �ASM�).

Pøeklad zdrojového textu programu probíhá ve dvou fázích. První z nich je
pøípravná (preprocessing), kdy dochází ke kontrole správnosti zápisu programu, je
provedeno rozvinutí makroinstrukcí, definování symbolù a vlo�ení souborù. Bìh této
fáze je mo�né øídit pomocí direktiv pøekladaèe, a� u� pøímo zapsaných ve zdrojovém
textu programu nebo nastavených pøes dialogové okno integrovaného prostøedí.
Po dokonèení pøípravné fáze probíhá vlastní pøeklad zdrojového textu programu
do binárního kódu. Výstupem pøekladaèe jsou následující soubory:

l tzv. �listing�, který obsahuje kompletní protokol o prùbìhu pøekladu, oèíslované
øádky zdrojového textu, oznaèené chyby, tabulku pou�itých symbolù a jejich
referencí. Tento soubor má pøíponou �LST�.

l soubor s binárním kódem zvoleného procesoru ve formátu INHEX-8M nebo
INHEX-16 (dáno nastavením pøekladaèe v dialogu integrovaného prostøedí).
Soubor má pøíponu �HEX�.

l vyskytnou-li se pøi pøekladu chyby, je vytvoøen chybový soubor, ve kterém je
uvedeno, ve kterém souboru a na jakém øádku byla chyba nalezena a struèný
popis chyby. Soubor má pøíponu �ERR�.

l tzv. �object file�, který obsahuje informace dùle�ité pro integrované prostøedí,
jako napø. jména a hodnoty pou�itých symbolù a odkazy na øádky zdrojového
textu programu (nutné pro krokování). Soubor má pøíponu �OBJ�.

Vstupní soubor Pøekladaè jazyka Výstupní soubory

*.ASM *.LST, *.HEX

*.OBJ, *.ERR

Blokové schéma funkce pøekladaèe:
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4.1 Zdrojový text programu
Zdrojový text programu je slo�en z programových øádkù. Programový øádek je

obecnì slo�en ze ètyø èástí, které jsou navzájem oddìleny pomocí mezer nebo
tabelátorù. Formát programového øádku je:

kde:

l návì�tí - je symbolický odkaz na pøíslu�ný øádek programu, který se u�ívá
pøedev�ím k zadání cíle skokù pøi vìtvení programu. Návì�tí není povinné a
zpravidla se u�ívá jen tehdy, je-li potøeba na pøíslu�ný øádek provést skok z jiného
místa programu. Jméno návì�tí musí splòovat podmínky kladené na symboly (viz
symboly)

l pøíkaz - mnemotechnická zkratka instrukce z instrukèního souboru daného
procesoru (viz instrukèní soubor) nebo direktiva pøekladaèe (viz direktivy
pøekladaèe)

l operandy - operandy instrukce nebo direktivy pøekladaèe, jejich poèet závisí na
typu instrukce (viz instrukèní soubor) nebo direktivy (viz direktivy pøekladaèe).
Operandy se mezi sebou oddìlují èárkou.

l komentáø - jakýkoliv text, který zaèíná støedníkem. Komentáøe mohou obsahovat
libovolné znaky a jsou pøekladaèem zcela ignorovány.

4.2 Konstanty
Konstantami chápeme ve�keré èíselné nebo textové informace v programu, které

jsou známé ji� v dobì pøekladu programu (tzn. ne obsahy registrù, kterým se pøiøazují
hodnoty a� pøi bìhu programu). Aritmetika pøekladaèe internì pøevádí èíselné konstanty
na 16 bitová kladná èísla (rozsah 0-65535) a textové konstanty na pole 16 bitových
èísel.

4.2.1 Èíselné konstanty

Èíselné konstanty slou�í napø. k zadávání operandù instrukcí (èísla registrù, èísla
bitù, konstanty). Mohou být zadány pomocí rùzných èíselných soustav nebo pomocí
kódù ASCII. K dispozici jsou èíselné soustavy: binární (základ 2), osmièková (základ
8), dekadická (základ 10) a hexadecimální (základ 16). Pøekladaèi je mo�no nastavit,
zda èísla s nespecifikovanou soustavou má chápat jako èísla dekadická nabo
hexadecimální (pøednastavená soustava). Pozor na zápisy, které mohou zpùsobit rùznou
interpretaci èísel v závislosti na pøednastavené soustavì (napø. 1D je v pøednastavené
dekadické soustavì 1, zatím co v soustavì hexadecimální 1D = 29 dekadicky).
V zápisech soustavy se nerozli�ují malá a velká písmena, tj. napø. 22h=22H.
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4.2.2 Textové konstanty

Textové konstanty pøedstavují speciální typ konstanty, kterou si je mo�né pøedstavit
jako pole o nìkolika prvcích, kde ka�dý prvek pole je èíselná konstanta. Textové
konstanty nelze pou�ít v�ude, nebo� jejich pou�ití je povoleno pouze v následujících
pøípadech:

l definice tabulky (direktiva TABLE)

l definice obsahu programové pamìti (direktivy DB, DW)

l zadání konstantního pole bajtù (direktiva CONST BYTE[])

Textové konstanty se skládají z ASCII znakù uzavøených v uvozovkách. (Pø. �Toto
je text�). Potøebujeme-li vlo�it do øetìzce netisknutelné znaky nebo jiné èíselné hodnoty,
je tak mo�no uèinit pomocí hexadecimálních kódù znakù ve formátu \x<hex. èíslo>
(Pø. �text1\x20text2� vlo�í ASCII znak s hexadecimálním kódem 20 (mezera) mezi
text1 a text2).

4.3 Výrazy
Výrazem rozumíme matematické nebo logické operace provádìné mezi

konstantami. Napø. �3+4� je výraz, který pøedstavuje matematický souèet konstant
3 a 4, jeho� výsledkem je konstanta 7. Pro vytváøení aritmetických a logických výrazù
je mo�no vyu�ít operace, které shrnuje tabulka. Je-li výraz slo�en z více matematických
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nebo logických operací, poøadí provádìných operací se urèí podle priorit. Nejdøíve se
vyhodnocují závorky, pak operace s prioritou 2, následují operace s prioritou 3, atd..
Má-li více operací stejnou prioritu, pak se výraz vyhodnocuje zleva doprava.V pøípadì
logických operací (v tabulce oznaèeny písmenem �L� v kolonce priorita) je výsledkem
vyhodnocení výrazu buï hodnota 0 (výraz je nepravdivý, napø. 1>2), nebo hodnota 1
(výraz je pravdivý, napø 2!=3).

4.4 Symboly
Pod pojmem symboly v programech rozumíme:

l symbolická jména konstant (definovaná direktivami EQU a SET),

l jména datových typù (definovaná direktivami BIT, BYTE, CONST BYTE),

l návì�tí (viz programový øádek),

l jména makroinstrukcí (viz makroinstrukce).

Ka�dý symbol má své jméno a vlastní definici symbolu, její� zápis závisí na tom,
o jaký typ symbolu se jedná.
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Jméno symbolu musí být v celém programu jedineèné a musí splòovat následující
podmínky, aby bylo správnì interpretováno:

1. musí zaèínat písmenem �A�-�Z�, �a�-�z�,

2. smí být slo�eno pouze z písmen �A�-�Z�, �a�-�z�, èísel �0�-�9� a podtr�ítka �_�,
tedy nesmí obsahovat oddìlovaèe (mezera, tabulátor).

4.4.1 Symbolická jména konstant

Chceme-li v programu nadefinovat symbolické jméno pro konstantu, mù�eme
pou�ít direktivy pøekladaèe EQU nebo SET. Obì direktivy mají stejný zápis a
symbolickému jménu pøiøazují hodnotu (konstantu). Místo hodnoty lze uvést i výraz, a
pak se symbolickému jménu pøiøadí hodnota vzniklá vyhodnocením výrazu.

<jméno symbolu>  EQU  <hodnota>
<jméno symbolu>  SET  <hodnota>

Pø: Data1 SET 13h
Data2 EQU 10h
Data3 EQU (1+Data1)*Data2

Rozdíl mezi direktivou EQU a SET spoèívá pouze v mo�nosti zmìnit hodnotu
symbolu. Je-li hodnota symbolu definovaná direktivou SET, je mo�né jí libovolnì
pøiøadit novou hodnotu buï opìt direktivou SET nebo direktivou EQU. Je-li hodnota
symbolu definovaná pomocí direktivy EQU, pøi pokusu u pøedefinování hodnoty jak
direktivou EQU, tak i direktivou SET pøekladaè ohlásí chybu.

4.4.2 Datové typy

Datové typy byly do programovacího jazyka zavedeny pøedev�ím pro ulehèení
práce s registry procesoru. Jejich základním rysem je, �e umo�òují zcela jednoznaènì
adresovat bajty nebo bity. Definice datového typu je slo�ena ze jména symbolu
(splòujícího podmínky kladané na jméno symbolu), klíèového slova oznaèujícího datový
typ a buï informací o umístìní v pamìti (adresa, bit, banka), nebo hodnoty.

Kromì základních typù je mo�né definovat i roz�íøený typ - pole. Pole je tvoøeno
prvky stejného typu a jeho velikost je nutné u pole bitù a pole bajtù zadat. Jednotlivé
prvky pole se èíslují od 0 a jsou pøístupné pomocí indexù, které se zapisují bezprostøednì
za jméno symbolu do hranatých závorek. Jméno symbolu bez indexu oznaèuje první
prvek pole stejnì tak jako jméno symbolu s indexem 0.
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Typ bajt je pøedurèen pro pou�ití v instrukcích, které pracují s registry, typ bit je
urèen pro bitovì orientované instrukce a typ konstanta je vhodný pro instrukce
vy�adující konstanty.

Pøekladaè jazyka rozeznává a pracuje s následujícími datovými typy:

l Byte - jeden registr (bajt) v datové pamìti. Definice se skládá z urèení adresy a
banky registru (viz pøíklad).

<jméno symbolu> BYTE @<adresa>,<banka>

l Bit - jeden bit registru v datové pamìti. Definice se skládá z urèení adresy a
banky registru a èísla bitu daného registru (0=LSB, 7=MSB). Není-li èíslo bitu
uvedeno, pøedpokládá se 0 (viz pøíklad)

<jméno symbolu> BIT @<adresa>,<bit>,<banka>

l Byte Array - pole registrù (bajtù) v datové pamìti. Definice se skládá z rozmìru
pole (udávajícího kolika bajty je pole tvoøeno) a adresy a banky, které udávají
adresu prvního bajtu pole. Následující prvky pole (bajty) jsou alokovány smìrem
k vy��ím adresám. (viz pøíklad).

<jméno symbolu> BYTE[rozmìr] @<adresa>,<banka>

l Bit Array - pole bitù v datové pamìti. Definice se skládá z rozmìru udávajícího
kolika prvky (bity) je pole tvoøeno, adresy a banky registru a bitu daného registru.
V�echny tyto údaje pøesnì adresují první prvek pole (bit). Dal�í prvky pole jsou
alokovány smìrem k významnìj�ím bitùm a smìrem k vy��ím adresám. Není-li
èíslo bitu uvedeno, pøedpoládá se 0 (viz pøíklad).

<jméno symbolu> BIT[rozmìr] @<adresa>,<bit>,<banka>

l Const Byte - 8 bitová konstanta (bajt), ekvivalent symbolù definovaných pomocí
direktivy EQU. Definice se skládá z hodnoty, která se pøiøadí symbolu. Místo
hodnoty lze uvést výraz, pak se symbolu pøiøadí hodnota odpovídající výsledku
vyhodnocení výrazu (viz pøíklad).

<jméno symbolu> CONST BYTE = <hodnota>

l Const Byte Array - pole 8 bitových konstant (bajtù). Definice se v tomto pøípadì
skládá z rozmìru pole, a hodnot oddìlených èárkami. Pokud není rozmìr pole
èíselnì uveden, automaticky se vypoèítá podle poètu uvedených hodnot. Hodnoty
lze zadat jako èíselnou konstantu, výraz, textovou konstantu nebo i ji� definované
pole konstantních bajtù.

<jméno symbolu> CONST BYTE[rozmìr] = <hodnota> {,<hodnota>�}
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  Následující pøíklad demonstruje zápisy a umístìní rùzných datových typù. Nejsou
udány banky, proto se pøedpoládá pøednastavená banka 0.

pocet   BYTE     @8
stav    BIT      @9
pole    BYTE[3]  @.11
bity    BIT[10]  @9,2
cislo   CONST BYTE = 1+2*3
data    CONST BYTE[] = �text�, cislo, @stav, 22h, 3*5

aserdA 7 6 5 4 3 2 1 0
h80 tecop
h90 ]5[ytib ]4[ytib ]3[ytib ]2[ytib ]1[ytib ]0[ytib vats
hA0 ]9[ytib ]8[ytib ]7[ytib ]6[ytib
hB0 ]0[elop
hC0 ]1[elop
hD0 ]2[elop

Konstantní symboly nejsou pøímo v datové pamìti ulo�eny, jsou známy pouze
pøekladaèi, který je v pøípadì pou�ití v programu nahradí jejich numerickou hodnotou.
Hodnoty konstanty a pole konstant jsou: cislo=7, data=data[0]=116 (A�t�), data[1]=101
(A�e�), data[2]=120 (A�x�), data[3]=116 (A�t�), data[4]=7, data[5]=9 (adresa symbolu
�stav�), data[6]=34 (22h), data[7]=15.

Upozornìní: Typy bajt resp. bit a jejich pole pøedstavují obsah registru, resp.
hodnotu bitu, které nejsou v dobì pøekladu je�tì známy (napø. instrukce �CLRF pocet�
provede vynulování obsahu registru 8, nikoliv vynulování symbolu �pocet�). Proto
tyto datové typy je mo�né pou�ít pouze v kombinaci s vhodnými instrukcemi,
pro které jsou urèené. Pokud chceme získat adresu typu bajt bit nebo jejich pole, která
je pak chápána jako obecná konstanta, je nutné napsat pøed jméno symbolu znak
adresy �@�.

4.4.3 Návì�tí

Návì�tí se zadává jako první polo�ka v pøíkazovém øádku (viz pøíkazový øádek).
�e se jedná o definici návì�tí mù�e být zvýraznìno tím, �e se za jméno návì�tí zapí�e
dvojteèka, která se v�ak do jména návì�tí nikterak nepromítne, proto�e je ignorována.

Pø: ...
cti1 MOVLW 10h ;definuje návì�tí cti1
...
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Pokud je napøíklad potøeba definovat pro jednu adresu více návì�tí, je mo�né
pou�ít je�tì jeden zpùsob definice - tzv. samostatné návì�tí. Definujeme-li samostatné
návì�tí, nesmí být na øádku uveden pøíkaz ani direktiva. Komentáø na øádku být mù�e.
Navíc musí samostatné návì�tí zaèínat v prvním sloupci zdrojového textu, nebo musí
být zakonèeno dvojteèkou.

Pø: ...
labe1:
label2 CLRF 8h ;definuje dvì návì�tí

4.5 Instrukèní soubor procesorù PIC
Instrukèní soubor je dán výrobcem procesoru, tj. v na�em pøípadì firmou

Microchip. Ka�dá rodina procesorù má svùj instrukèní soubor, který je zpravidla
vytvoøen pomocí zkratek operací, které daný procesor umo�òuje provádìt. Zkratky se
oznaèují jako mnemotechnické (symbolické) názvy instrukcí.

Pøekladaè umo�òuje pøekládat programy pro rodiny procesorù 16C5X a 16CXX.
Obì rodiny procesorù jsou si velice podobné a mají a� na malé odchylky u nìkterých
typù stejnou instrukèní sadu (mnemotechnické názvy instrukcí). Binární kódy instrukcí
obou rodin jsou v�ak rozdílné, nebo� rodina 16C5X pou�ívá 12 bitù �iroké instrukce,
a 16CXX pou�ívá 14 bitù �iroké instrukce.

Obecnì lze instrukèní soubor obou rodin rozdìlit na:

l bajtovì orientované instrukce

l bitovì orientované instrukce

l instrukce pracující s konstantou

l øídící instrukce

4.5.1 Bajtovì orientované instrukce

Bajtovì orientované instrukce pracují s datovým registrem. Umo�òují provádìt
pøesuny dat mezi datovým registrem a pomocným registrem W, modifikaci hodnoty
registru (pøiètení 1, odeètení 1, rotace, ...) a aritmetické a logické operace s hodnotou
v registru a ve W.

Operandem instrukce je èíslo registru, které mù�e být zadáno pøímo konstantou
nebo pomocí datového typu bajt.

Vìt�ina instrukcí této kategorie vy�aduje je�tì druhý operand, udávající kam má
být ulo�en výsledek operace. Je-li zadána hodnota 0, je výsledek ulo�en do pomocného
registru W, je-li hodnota 1, je výsledek ulo�en do registru, který je zadán prvním
operandem. Pro tyto úèely má pøekladaè pøeddefinovány symboly W a F, kde W=0 a
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F=1. Pokud není uvedeno, kam má být výsledek ulo�en, bude ulo�en do registru, který
je zadán prvním operandem.

Pø: CLRF 8h ; vynulování obsahu registru 8h
; zvìt�í hodnotu reg. 10 o 1
INCF 10h,1
INCF 10h,F
INCF 10h
; hodnotu reg. 10 zvìt�enou o 1 ulo� do pom. reg. W
INCF 10h,0
INCF 10h,W
;pou�ijeme-li definice z pøíkladu datových typù, pak
MOVWF pole[1] ;zkopíruje obsah W do reg. 12

4.5.2 Bitovì orientované instrukce

Bitovì orinetované instrukce pracují s bity v datových registrech procesoru.
Umo�òují nastavit hodnotu bitu do logické jednièky nebo do logické nuly, nebo testovat
logickou hodnotu daného bitu a podle výsledku vìtvit program.

Operandem instrukcí tohoto typu mù�e být datový typ bit, pøíp. jeden prvek pole
bitù. Tyto typy obsahují kompletní urèení bitu.

Pokud nepou�ijeme zadání operandu pomocí typu bit, musíme pou�ít operandy
dva. První operand udává èíslo registru a druhý operand udává èíslo bitu v registru
(0-7).

Pø: BCF 8,2 ; vynuluje bit 2 registru 8
;pou�ijeme-li definice z pøíkladu datových typù, pak
BSF bity[2] ; nastaví bit 4 registru 9

4.5.3 Instrukce pracující s konstantou

Instrukce pracující s konstantou slou�í k modifikaci obsahu pomocného registru
W a k provádìní vìtvení programu a volání podprogramù. Patøí sem i instrukce skoku
(GOTO), volání (CALL) a návratu z podprogramu (RETLW).

Operandem tohoto typu instrukcí je konstanta definovaná libovolným zpùsobem.

Pø: MOVLW 10h ; zápis hodnoty 10h do pom. registru W

4.5.4 Øídící instrukce

Øídící instrukce slou�í pøedev�ím k øízení èinnosti procesoru (pøechod do re�imu
�sleep�, vynulování èítaèe �Watchdog�). Øídící instrukce kromì instrukce TRIS nemají
operand, nebo� nepotøebují �ádné dodateèné informace. Instrukce TRIS slou�í
k nastavení jednotlivých pinù portù do vstupního nebo výstupního módu a parametrem
je èíslo registru portu.
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4.5.5  Pøehled instrukcí rodiny PIC 16C5X

ADDWF - ADD W and F
Zápis: ADDWF f,d
Operace: ( W + f ) → d
Popis: Seète obsah registrù f a W, výsledek ulo�í do registru W (je-li d=0) nebo

do registru f (je-li d=1).
Cyklù: 1 Ovlivòuje: C, DC, Z

ANDLW - AND Literal and W
Zápis: ANDLW k
Operace: ( k & W ) → W
Popis: Provede logický souèin obsahu registru W s konstantou k, výsledek ulo�í

do registru W.
Cyklù: 1 Ovlivòuje: Z

ANDWF - AND W with F
Zápis: ANDWF f,d
Operace: ( W & f ) → d
Popis: Provede logický souèin obsahu registru f a W, výsledek ulo�í do registru

W (je-li d=0) nebo do registru f (je-li d=1).
Cyklù: 1 Ovlivòuje: Z

BCF - Bit Clear F
Zápis: BCF f,b
Operace: 0 → f(b)
Popis: Vynuluje bit b v registru f.
Cyklù: 1 Ovlivòuje: -

BSF - Bit Set F
Zápis: BSF f,b
Operace: 1 → f(b)
Popis: Nastaví do log. 1 bit b v registru f.
Cyklù: 1 Ovlivòuje: -

BTFSC - Bit Test F, Skip if Clear
Zápis: BTFSC f,b
Operace: skok, je-li f(b)=0
Popis: Je-li bit b v registru f v log. 0, následující instrukce se neprovede. Jinak

program pokraèuje na následující instrukci.
Cyklù: 1(2- pøi skoku) Ovlivòuje: -
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BTFSS - Bit Test F, Skip if Set
Zápis: BTFSS f,b
Operace: skok, je-li f(b)=1
Popis: Je-li bit b v registru f nastaven do log. 1, následující instrukce se neprovede.

Jinak  program pokraèuje na následující instrukci.
Cyklù: 1(2- pøi skoku) Ovlivòuje: -

CALL - subroutine CALL
Zápis: CALL k
Operace: PC+1 → TOS; k → PC<7:0>; 0 → PC<8>; PA2,PA1,PA0 → PC<11:9>
Popis: Návratovou adresu (PC+1) ulo�í do zásobníku, konstanta k se ulo�í na

spodních 8 bitù PC, 9. bit PC se vynuluje, zbývající 3 bity PC se doplní z
bitù PA2,PA1 a PA0. Program pokraèuje podprogramem na adrese PC.

Cyklù: 2 Ovlivòuje: -

CLRF - CLeaR F register
Zápis: CLRF f,d
Operace: 00h → f, 00h → d
Popis: Vynuluje obsah registru f.
Cyklù: 1 Ovlivòuje: Z

CLRW - CLeaR W register
Zápis: CLRW
Operace: 00h → W
Popis: Vynuluje obsah registru W.
Cyklù: 1 Ovlivòuje: Z

CLRWDT - CLeaR WatchDog Timer
Zápis: CLRWDT
Operace: 00h → WDT, 0 → WDT pøeddìliè
Popis: Nuluje èítaè �Watchdog� a jeho pøeddìlièku.
Cyklù: 1 Ovlivòuje: 1 → TO, 1 → PD

COMF - COMplement F
Zápis: COMF f,d
Operace: /f → d
Popis: Zamìní jednièky a nuly v obsahu registru f (jednièkový doplnìk èísla) a

výsledek ulo�í do registru W (je-li d=0) nebo do registru f (je-li d=1).
Cyklù: 1 Ovlivòuje: Z
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DECF - DECrement F
Zápis: DECF f,d
Operace: ( f - 1 ) → d
Popis: Odeète jednièku od obsahu registru f a výsledek ulo�í do registru W

(je-li d=0) nebo do registru f (je-li d=1).
Cyklù: 1 Ovlivòuje: Z

DECFSZ - DECrement F Skip if Zero
Zápis: DECFSZ f,d
Operace: ( f - 1 ) → d; skok, je-li výsledek 0
Popis: Odeète jednièku od obsahu registru f a výsledek ulo�í do registru W

(je-li d=0) nebo do registru f (je-li d=1). Je-li výsledek 0, následující instrukce
se neprovede. Jinak program pokraèuje na následující instrukci.

Cyklù: 1(2 - je-li skok) Ovlivòuje: Z

GOTO - GO TO address (nepodmínìný skok)
Zápis: GOTO k
Operace: k → PC<8:0>; PA2,PA1,PA0 → PC<11:9>
Popis: Konstanta k (bere se z ní 9 bitù !!!) se ulo�í na spodních 9 bitù PC, zbývající

3 bity PC se doplní z bitù PA2,PA1 a PA0 v registru STATUS procesoru.
Program pokraèuje kódem na adrese PC.

Cyklù: 2 Ovlivòuje: -

INCF - INCrement F
Zápis: INCF f,d
Operace: ( f + 1 ) → d
Popis: Pøiète jednièku k obsahu registru f a výsledek ulo�í do registru W

(je-li d=0) nebo do registru f (je-li d=1).
Cyklù: 1 Ovlivòuje: Z

INCFSZ - INCrement F Skip if Zero
Zápis: INCFSZ f,d
Operace: ( f + 1 ) → d; skok, je-li výsledek 0
Popis: Pøiète jednièku k obsahu registru f a výsledek ulo�í do registru W

(je-li d=0) nebo do registru f (je-li d=1). Je-li výsledek 0, následující instrukce
se neprovede. Jinak program pokraèuje na následující instrukci.

Cyklù: 1(2 - je-li skok) Ovlivòuje: Z
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IORLW - Inclusive OR Literal with F
Zápis: IORLW k
Operace: ( W | k ) → W
Popis: Provede logický souèet (OR) obsahu registru W s konstantou k, výsledek

ulo�í do registru W.
Cyklù: 1 Ovlivòuje: Z

IORWF - Inclusive OR W with F
Zápis: IORWF f,d
Operace: ( W | f ) → d
Popis: Provede logický souèet (OR) obsahu registrù f a W, výsledek ulo�í do registru

W (je-li d=0) nebo do registru f (je-li d=1).
Cyklù: 1 Ovlivòuje: Z

MOVF - MOVe F
Zápis: MOVF f,d
Operace: (f) → d
Popis: Obsah registru f pøesune do registru W (je-li d=0) nebo zpìt do registru f

(je-li d=1).
Cyklù: 1 Ovlivòuje: Z

MOVWF - MOVe W to F
Zápis: MOVWF f,d
Operace: W → d
Popis: Obsah registru W pøesune do registru f
Cyklù: 1 Ovlivòuje: -

NOP - No OPeration
Zápis: NOP
Operace: neprovede nic
Popis: neprovede nic
Cyklù: 1 Ovlivòuje: -

OPTION - load OPTION register
Zápis: OPTION
Operace: W → OPTION
Popis: Obsah registru W pøesune do registru OPTION
Cyklù: 1 Ovlivòuje: -
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RETLW - RETurn Literal to W
Zápis: RETLW k
Operace: k → W; TOS → PC;
Popis: Návrat z podprogramu. Naplní PC ze zásobníku a registr W naplní

konstantou k.
Cyklù: 1 Ovlivòuje: -

RLF - Rotate Left F through carry
Zápis: RLF f,d
Operace: f<n> → d<n+1>; f<7> → C; C → d<0>
Popis: Rotuje obsah registru f doleva pøes bit C (carry), výsledek ulo�í do registru

W (je-li d=0) nebo do registru f (je-li d=1).
Cyklù: 1 Ovlivòuje: C

RRF - Rotate Right F through carry
Zápis: RRF f,d
Operace: f<n> → d<n-1>; f<0> → C; C → d<1>
Popis: Rotuje obsah registru f doprava pøes bit C (carry), výsledek ulo�í do registru

W (je-li d=0) nebo do registru f (je-li d=1).
Cyklù: 1 Ovlivòuje: C

SLEEP - SLEEP
Zápis: SLEEP
Operace: 0 → PD, 1 → TO, 00h → WDT, 0 → WDT pøeddìliè
Popis: Vynuluje �power-down� bit PD, nastaví �time-out� bit TO, vynuluje èítaè

�Watchdog� a jeho pøeddìlièku. Procesor pøejde do stavu SLEEP, oscilátor
je vypnut.

Cyklù: 1 Ovlivòuje: TO, PD

SUBWF - SUBtract W from F
Zápis: SUBWF f,d
Operace: ( f - W ) → d
Popis: Odeète obsah registru W od obsahu registru f, výsledek ulo�í do registru W

(je-li d=0) nebo do registru f (je-li d=1).
Cyklù: 1 Ovlivòuje: C, DC, Z

SWAPF - SWAP F
Zápis: SWAPF f,d
Operace: f<0:3> → d<4:7>; f<4:7> → d<0:3>
Popis: Zamìní spodní a horní 4 bity (nibble) obsahu registru f, výsledek ulo�í do

registru W (je-li d=0) nebo do registru f (je-li d=1).
Cyklù: 1 Ovlivòuje: -
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TRIS - load TRIS register
Zápis: TRIS f
Operace: W → TRIS registr f
Popis: Ulo�í do øídícího registru portù TRIS (f=5, 6, nebo 7) obsah registru W,
Cyklù: 1 Ovlivòuje: -

XORLW - Exclusive OR Literal with W
Zápis: XORLW k
Operace: ( W xor k ) → W
Popis: Provede nonekvivalneci (XOR) obsahu registru W s konstantou k, výsledek

ulo�í do registru W.
Cyklù: 1 Ovlivòuje: Z

XORWF - Exclusive OR W with f
Zápis: XORWF f,d
Operace: ( W xor f ) → d
Popis: Provede nonekvivalenci (XOR) obsahu registrù f a W, výsledek ulo�í do

registru W (je-li d=0) nebo do registru f (je-li d=1).
Cyklù: 1 Ovlivòuje: Z

4.5.6  Instrukèní soubor rodiny PIC 16CXX

Jeliko� instrukèní soubor rodiny PIC 16CXX je nadmno�inou instrukèního souboru
rodiny PIC 16C5X, zamìøíme se v popisu pouze na ty instrukce, jejich� zpùsob
provádìní je jiný ne� bylo popsáno nebo které se v instrukèním souboru PIC 16C5X
nevyskytují.

ADDLW - ADD Literal to W
Zápis: ADDLW k
Operace: ( W + k ) → W
Popis: Provede aritmetický souèet obsahu registru W s konstantou k, výsledek

ulo�í do registru W.
Cyklù: 1 Ovlivòuje: C, DC, Z

CALL - subroutine CALL
Zápis: CALL k
Operace: PC+1 → TOS; k → PC<10:0>; PCLATH<4:3> → PC<12:11>
Popis: Návratovou adresu (PC+1) ulo�í do zásobníku, konstanta k (vezme se z ní

11 bitù !!!) se ulo�í na spodních 11 bitù PC, zbývající bity PC se doplní z
registru PCLATH (f3). Program pokraèuje podprogramem na adrese PC.

Cyklù: 2 Ovlivòuje: -
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GOTO - GO TO address (nepodmínìný skok)
Zápis: GOTO k
Operace: k → PC<10:0>; PCLATH<4:3> → PC<12:11>
Popis: Konstanta k (bere se z ní 11 bitù !!!) se ulo�í na spodních 11 bitù PC,

zbývající bity PC se doplní z registru PCLATH (f3). Program pokraèuje
kódem na adrese PC.

Cyklù: 2 Ovlivòuje: -

RETFIE - RETurn From IntErrupt
Zápis: RETFIE
Operace: TOS → PC; 1 → GIE
Popis: Návrat z pøeru�ení. Naplní hodnotu PC ze zásobníku a povolí pøeru�ení

nastavením bitu GIE (Global Interrupt Enable) do log. 1.
Cyklù: 2 Ovlivòuje: -

RETURN - RETURN from subroutine
Zápis: RETURN
Operace: TOS → PC;
Popis: Návrat z podprogramu. Naplní hodnotu PC ze zásobníku.
Cyklù: 2 Ovlivòuje: -

SUBLW - SUBtract Literal and W
Zápis: SUBLW k
Operace: ( k - W ) → W
Popis: Odeète obsah registru W od konstanty k, výsledek ulo�í do registru W.
Cyklù: 1 Ovlivòuje: C, DC, Z

4.6 Direktivy pøekladaèe
Direktivy pøekladaèe slou�í k nastavení parametrù pøekladu a nejsou pøekládány

do binárního kódu procesoru. Výjimku tvoøí pouze ditektivy DB, DW a TABLE, které
ukládají data do programové pamìti procesoru. Èást direktiv (napø. zapnutí rozli�ování
velkých a malých písmen, nastavení délky stránky v listingu, potlaèení vytváøení
nìkterých souborù, �) se nastavuje v dialogovém oknì integrovaného prostøedí.
Zbývající direktivy (napø. vlo�ení souboru, nastavení adresy pro pøeklad, podmínìný
pøeklad, definování makroinstrukcí, �) se zapisují pøímo do zdrojového textu programu.
Tìmito direktivami se zabývá tato èást pøíruèky. U vìt�iny direktiv je mo�né provést
zápis dvìma zpùsoby (viz zápisy jednotlivých direktiv). Pøi pou�ití varianty pou�ívající
znak �#� (ekvivalent zápisu direktiv pøekladaèe pou�ívaný ve vy��ích programovacích
jazycích - napø. C), nelze na daném øádku definovat návì�tí.
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4.6.1 Pøehled direktiv

BANK pøednastavení banky registrù v datové pamìti
BIT definice datového typu bit nebo pole bitù
BYTE definice datového typu bajt nebo pole bajtù
CONST BYTE definice konstanty nebo pole konstant
DB ulo�ení dat do programové pamìti
DW ulo�ení dat do programové pamìti
ELSE pøepínaè podmínìného pøekladu
END konec programu
ENDIF konec podmínìného pøekladu
ENDM konec definice makroinstrukce
EQU pøiøazení hodnoty symbolu
IF zaèátek podmínìného pøekladu
INCLUDE vlo�ení souboru
LOCAL definice lokálního návì�tí v makroinstrukci
MACRO zaèátek definice makroinstrukce
ORG nastavení adresy pøekladu
PRAGMA nastavení parametrù pøekladaèe (potlaèení generování

varovných chybových hlá�ení - �warnings�)
SET pøiøazení hodnoty symbolu
TABLE definice tabulky hodnot

4.6.2 Direktiva BANK

Direktiva BANK slou�í k pøednastavení èísla datové banky. Pokud definujeme
datové typy (napø. bajt nebo bit) a nezadáme èíslo banky, bude pou�ita pøednastavená
banka. Nepou�ije-li se direktiva BANK, je pøednastavená datová banka 0.

Zápis: #BANK  <èíslo banky>

Pø: #BANK 0  ; pøednastaví banku 0

4.6.3 Direktiva BIT

Direktiva BIT slou�í k definici datového typu bit nebo pole bitù. Definice se
skládá ze jména symbolu, klíèového slova BIT (v pøípadì pole bitù BIT[]) a
jednoznaèného urèení bitu (adresa registru, èíslo bitu, èíslo banky), které v pøípadì
definice pole bitù urèuje polohu prvního prvku pole. Pokud není uvedena banka,
pøedpokládá se banka pøednastavená direktivou BANK. Pokud není uvedeno èíslo
bitu, pøedpokládá se bit 0 (LSB). Pokud uvádíme èíslo banky, musíme zadat i èíslo
bitu. Definujeme-li pole bitù, musíme zadat rozmìr pole, který øíká, kolik má pole
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prvkù (bitù). Jednotlivé prvky pole (bity) se rozli�ují indexem zapsaným v hranatých
závorkách za jménem pole. Prvky pole se èíslují od nuly. Pokud není index uveden,
pøedpokládá se prvek s indexem 0. Jednotlivé prvky pole (bity) se alokují od zadané
pozice smìrem k MSB a vy��ím adresám (viz datové typy).

Zápis: <symbol> BIT @<adresa>, {<bit>, {<banka>}}
<symbol> BIT[<rozmìr>] @<adresa>,{<bit>,{<banka>}}

Pø: bitik BIT @8,1 ; bit 1 v registru 8
pole1 BIT[3] @8,2 ; pole 3 bitù

4.6.4 Direktiva BYTE

Direktiva BYTE slou�í k definici datového typu bajt nebo pole bajtù. Definice se
skládá ze jména symbolu, klíèového slova BYTE (v pøípadì pole bajtù BYTE[]) a
jednoznaèného urèení bajtu (adresa registru, èíslo banky), které v pøípadì definice
pole bitù urèuje polohu prvního prvku pole (bajtu). Pokud není uvedena banka,
pøedpokládá se banka pøednastavená direktivou BANK. Definujeme-li pole bajtù,
musíme zadat rozmìr pole, který øíká, kolik má pole prvkù (bajtù). Jednotlivé prvky
pole (bajty) se rozli�ují indexem zapsaným v hranatých závorkách za jménem pole.
Prvky pole se èíslují od nuly. Pokud není index uveden, pøedpokládá se prvek s indexem
0. Jednotlivé prvky pole (bajty) se alokují od zadané adresy smìrem k vy��ím adresám
(viz datové typy).

Zápis: <symbol> BYTE @<adresa>, {<banka>}
<symbol> BYTE[<rozmìr>] {@<adresa>, {<banka>}}

Pø: bajt1 BYTE @9
pole2 BYTE[2] @.10 ; pole 2 bajtù

4.6.5 Direktiva CONST BYTE

Direktiva CONST BYTE slou�í k definici konstanty (podobnì jako direktivy EQU
a SET) a pole konstant (CONST BYTE[]). Definice se skládá ze jména symbolu,
klíèového slova CONST BYTE (v pøípadì pole bajtù CONST BYTE[]) a hodnoty.
Hodnota mù�e být zadána jako èíselná konstanta, textová konstanta nebo výraz.
Definujeme-li pole konstant, nemusíme zadat rozmìr pole, nebo� ten se automaticky
zjistí podle poètu zadaných hodnot. Jednotlivé prvky pole (bajty) se rozli�ují indexem
zapsaným v hranatých závorkách za jménem pole. Prvky pole se èíslují od nuly. Pokud
není index uveden, pøedpokládá se prvek s indexem 0.

Zápis: <symbol> CONST BYTE = <hodnota>
<symbol> CONST BYTE[{<rozmìr>}] = <hodnoty>
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Pø: konst1 CONST BYTE = 10h
konst2 CONST BYTE[] = �abcd�, 0x20, konst1

4.6.6 Direktiva DB

Direktiva DB slou�í k ulo�ení konstanty o rozsahu 8 bitù (bajt) do programové
pamìti na aktuální adresu. Hodnota mù�e být zadána èíselnou konstantou, textovou
konstantou, polem konstant i výrazem.

Zápis: {<návì�tí>} DB <hodnota>, {<hodnota>, ...}

Pø: ; ulo�ení textu do programové pamìti na adr. 100h
ORG 100h
DB �verze programu 1.0�

4.6.7 Direktiva DW

Direktiva DW slou�í k ulo�ení konstanty o rozsahu maximálnì �íøky instrukce
zvolené rodiny procesorù do programové pamìti na aktuální adresu. Hodnota mù�e
být zadána èíselnou konstantou, textovou konstantou, polem konstant i výrazem.

Zápis: {<návì�tí>} DW <hodnota>, {<hodnota>, ...}

Pø: ; zápis konfiguraèních pojistek 16C84
ORG 2007h
DW 0xXXX

4.6.8 Direktiva END

Direktiva END oznaèuje konec programu. Ve�keré øádky za direktivou END jsou
pøekladaèem ignorovány.

Zápis1: {<návì�tí>} END
Zápis2: #END

Pø: END

4.6.9 Direktiva EQU

Direktiva EQU slou�í k definici hodnoty symbolu. Hodnota mù�e být zadána
jako èíselná konstanta nebo výraz. Pokud ji� symbol stejného jména existuje, pøekladaè
ohlásí chybu.
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Zápis: <symbol> EQU <hodnota>

Pø: konst1   EQU  20+6*2
konst2   EQU  konst1*3

4.6.10 Direktivy IF - ELSE - ENDIF

Direktivy IF - ELSE - ENDIF slou�í k definování bloku podmínìného pøekladu.
Definice bloku zaèíná direktivou IF, za kterou následuje výraz, který je mo�né
vyhodnotit pøi pøekladu (musí tedy být slo�en pouze z konstant nebo symbolù, kterým
byla pøiøazena hodnota). Vyhodnocením výrazu mohou nastat dvì mo�nosti:

 1. Výraz byl vyhodnocen jako pravdivý (výsledkem vyhodnocení bylo èíslo rùzné
od nuly), pak se pøekládá pouze <kód TRUE>, zatím co <kód FALSE> je
pøekladaèem ignorován.

2. Výraz byl vyhodnocen jako nepravdivý (výsledkem vyhodnocení byla nula), pak
se pøekládá pouze <kód FALSE>, zatím co <kód TRUE> je pøekladaèem
ignorován.

Direktiva ELSE oddìluje <kód TRUE> a <kód FALSE>. Direktiva ENDIF
ukonèuje definici bloku podmínìného pøekladu.

Zápis: #IF <výraz> Nebo: IF <výraz>
  <kód TRUE>   <kód TRUE>
#ELSE ELSE
  <kód FALSE>   <kód FALSE>
#ENDIF ENDIF

4.6.11 Direktiva INCLUDE

Direktiva INCLUDE slou�í k vlo�ení obsahu souboru do zdrojového textu
programu. Pou�ívá se pro vlo�ení definic symbolù, makroinstrukcí, knihoven apod..
Operandem direktivy je jméno souboru, který má být vlo�en. Jméno souboru musí být
uzavøeno v uvozovkách. Je povoleno maximálnì devítinásobné vnoøení.

Zápis1: {<návì�tí>} INCLUDE �<jméno souboru>�
Zápis2: #INCLUDE �<jméno souboru>�

Pø: INCLUDE �PICREG.EQU�

4.6.12 Direktivy MACRO - LOCAL -ENDM

Direktivy MACRO - LOCAL - ENDM slou�í k definování makroinstrukcí.
Makroinstrukce je blok instrukcí, které zpravidla tvoøí nìjaký funkèní celek (napø.
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generátor zpo�dìní) nebo èasto se opakující úsek kódu. Makroinstrukce zaèíná definicí,
ve které je uvedeno jméno makroinstrukce a její argumenty, které slou�í pro pøedávání
hodnot instrukcím tvoøící tìlo makroinstrukce. Argumentù mù�e být maximálnì 10.
Uvnitø makra mù�e být voláno jiné makro, ov�em poèet vzájemných vnoøení maker je
omezeno na 5.

Zápis1: #MACRO <jméno makra> {<argumenty>}
{#LOCAL <lok.n.>}
<instrukce>
#ENDM

Zápis2: <jméno makra> MACRO {<argumenty>}
{LOCAL <lok.n.>}
<instrukce>
ENDM

Pøíkladem definice makroinstrukce mù�e být makroinstrukce moje1, která má
dva argumenty pojmenované par_a, par_b a která provádí ulo�ení konstanty
(reprezentovaná parametrem par_a) do datového registru (reprezentovaného par_b).

Pø: #MACRO moje1 par_a, par_b
  Movlw par_a
  Movwf par_b,F
#ENDM

Volání makroinstrukce má tvar:

Zápis: {<návì�tí>} <jméno makra> {<argumenty>}

Pak kód:

moje1 11h, 10h

Bude rozvinut do:

Movlw 11h
Movwf 10h

Pøekladaè umo�òuje automatické pou�ití definované knihovny maker pøi pøekladu
zdrojového textu. V adresáøi, kde se nachází soubory vývojového prostøedí je soubor
STDPIC.MCR, který obsahuje nadefinované základní makroinstrukce pro zaji�tìní
kompatibility pøekladaèe s jinými produkty. Tento soubor je v�dy pøed provedením
kompilace programu pøekladaèem naèten, a tedy v�echny v nìm definované
makroinstrukce jsou v dobì pøekladu známé a pou�itelné ve Va�ich programech.
U�ivatelé si mohou do souboru STDPIC.MCR dopsat své vlastní makroinstrukce, ale
radìji doporuèujeme vytvoøit zvlá�tní soubor s makroinstrukcemi a ten vlo�it do
pøekladaèe pomocí direktivy INCLUDE.
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4.6.13 Direktiva ORG

Direktiva ORG slou�í k nastavení adresy programové pamìti, od které budou
pøekládány následné pøíkazy. Pomocí této direktivy je mo�né nastavit pøeklad
na libovolnou adresu programové pamìti. U procesoru 16C84 je tak mo�né napø.
pøímo zapisovat data do pamì�ového prostoru datové EEPROM, která je mapována
do adresového prostoru od adresy 2100h

Zápis: {<návì�tí>} ORG <hodnota>

Pø: ORG 1FFh ; resetovací vektor 16C54
Goto start

ORG 0
start ....

4.6.14 Direktiva PRAGMA

Direktiva PRAGMA slou�í k nastavení rùzných parametrù pøekladaèe jazyka
assembler. V souèasné dobì je implementována pouze mo�nost potlaèení generování
varování pøekladaèe (warnings) pøi kompilaci zdrojového textu programu. Tato direktiva
nemá vliv na hlá�ení varování pøekladaèe pøi nenalezení knihovny maker, toto varování
je generováno v�dy.

Zápis:  #pragma warn-

4.6.15 Direktiva SET

Direktiva SET slou�í (podobnì jako direktiva EQU) k definici hodnoty symbolu.
Hodnota mù�e být zadána jako konstanta nebo výraz. Hodnotu symbolu definovanou
direktivou SET lze zmìnit dal�í direktivou SET nebo EQU.

Zápis: <symbol> SET <hodnota>

Pø: konst1 SET  20+6*2
konst1 SET  konst1*3 ; pøedefinování hodnoty

4.6.16 Direktiva TABLE

Direktiva TABLE slou�í k definici tabulky hodnot v programové pamìti.
Pøi pøekladu se direktiva TABLE rozvine pomocí instrukcí RETLW, jejich� návratové
kódy vytvoøí po�adovanou tabulku. Hodnoty mohou být zadány jako èíselné konstanty,
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textové konstanty nebo výrazy.

Zápis1: {<návì�tí>} TABLE <hodnoty>
Zápis2: #TABLE <hodnoty>

Pø: ADDWF 2,1
TABLE 0xB7, 0x83, 0x11, 0x50

kód bude rozvinut do posloupnosti instrukcí:

ADDWF 2,1
RETLW 0xB7
RETLW 0x83
RETLW 0x11
RETLW 0x50

4.7 Chybová hlá�ení pøekladaèe a varování
Can not open input file �<jméno souboru>�

Soubor <jméno souboru> nebyl nalezen. Pøesvìdète se, zda takový soubor existuje.

Can not open include file �<jméno souboru>�
Direktivou INCLUDE je vlo�en soubor <jméno souboru>, který nelze otevøít.
Pøesvìdète se, zda pøi zadání jména souboru nedo�lo k pøeklepu, zda je uvedena
správná cesta k souboru (relativnì vzhledem k pracovnímu adresáøi) a zda soubor
skuteènì existuje.

Can not open output file �<jméno souboru>�
Nelze vytvoøit a zapsat výstupní soubor <jméno souboru>. Disk je buï plný
nebo je chránìn proti zápisu. Pokud pracujete v poèítaèové síti, mo�ná nemáte
dostatek pøístupových práv do aktuálního adresáøe.

Can not close file �<jméno souboru>�
Soubor byl otevøen, ale nemù�e být uzavøen. Patrnì do�lo k záva�né chybì
záznamového média nebo není dostatek místa pro ulo�ení souboru.

Can not compile this line
Pøekladaè nerozumí øádce zdrojového programu. Zkontrolujte, zda je direktiva
nebo mnemotechnický název instrukce syntakticky správnì.

Maximum number of included files or macros exceeded
Byl pøekroèen povolený poèet vkládání souborù. Mohlo se napø. stát, �e soubor
opakovanì vkládá sám sebe (direktivou INCLUDE) a do�lo k zacyklení. Provìøte
v ka�dém vkládaném souboru, jaké soubory jsou do nìj vkládány.

Unmatched parentheses.
Poèet otevøených závorek ve výrazu není shodný s poètem uzavøených závorek.
Zkontrolujte zápis výrazu.



80 DPIC/EPIC - u�ivatelská pøíruèka

Can not evaluate expression �<výraz>�
<výraz> nemù�e být vyhodnocen. Zkontrolujte zápis výrazu, zda jsou správnì
zapsány matematické výrazy a konstanty.

Can not add new label �<návì�tí>� to symbol table
<návì�tí> je v programu definováno více ne� jednou. Zkuste pou�ít jiné jméno.
Pokud je <návì�tí> souèástí makroinstrukce, nadefinujte <návì�tí> jako lokální
(direktiva LOCAL) nebo pøepi�te definici makroinstrukce.

Can not add new symbol �<symbol>� to symbol table
<symbol> ji� byl jednou definován. Zkuste pou�ít pro symbol jiné jméno.

Unknown data type
Neznámý datový typ.

Unknown data type or expression
Neznámý datový typ nebo výraz.

Code placed on address �<adresa>� replaced by another one
Do�lo k pøepisu programu na adrese <adresa>.

Keyword �const� must be followed by keyword �byte�
Za klíèovým slovem CONST musí následovat klíèové slovo BYTE.

Insufficient memory to add symbol �<symbol>� to symbol table
Do�lo k vyèerpání dostupné pamìti pro uchování symbolù. <symbol> není tedy
mo�né pøidat do tabulky symbolù. Zredukujte poèet nepou�ívaných symbolù.

Duplicate definition of symbol �<symbol>�
Pokus o pøedefinování hodnoty symbolu <symbol>.

Illegal bank number
�patné èíslo banky.

Address out of data memory
Adresa registru je mimo datovou pamì� zvoleného procesoru.

Command allowed for 16CXX family only
Tato instrukce je definována pouze v rodinì procesorù 16CXX.

Address out of program memory
Adresa programu je mimo programovou pamì�.

Bit number should be in range 0-7. Number truncated!
Èíslo bitu mù�e být pouze v rozsahu 0-7. Èíslo bylo oøíznuto na 3 spodní bity.

File Register number should be 0-#. Number truncated!
Èíslo registru mù�e být pouze v rozsahu 0-X. Èíslo bylo oøíznuto.

File Register number should be 0-47. Number truncated!�
Èíslo registru mù�e být pouze v rozsahu 0-47. Èíslo bylo oøíznuto.
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Call is possible to low 256 bytes of page only
V rodinì procesorù 16C5X je mo�né volat podprogramy, jejich� poèátek je
ve spodní polovinì stránky programové pamìti.

Literal value truncated to 8 bits
Konstanta vìt�í ne� 256 byla oøíznuta na 8 bitù.

Unknown data type
Neznámý datový typ.

Can not evaluate address
U datového typu nemù�e pøekladaè vyhodnotit adresu. Zkontrolujte, zda je adresa
uvozena znakem �@�.

Missing address
U datového typu není zadána adresa.

Can not evaluate bit number
U datového typu bit nebo pole bitù je �patnì zadáno èíslo bitu. Pravdìpodobnì
do�lo k pøeklepu, zkontrolujte zápis.

Can not evaluate bank number
U datového typu je �patnì zadáno èíslo banky registrù. Pravdìpodobnì do�lo
k pøeklepu, zkontrolujte zápis.

Bad constant syntax, �=� expected
�patný zápis definice typu CONST BYTE. Je oèekáván znak �=�, za kterým
musí následovat hodnota.

Illegal hexadecimal number
�patný zápis hexadecimálního èísla. Èíslo musí v�dy zaèínat èíslicí, ne písmenem.
Napø. FFh je �patnì, správnì má být 0FFh.

�]� expected
Chybí uzavírací závorka indexu pole.

Syntax error
�patný zápis pøíkazu nebo direktivy

Bad number of real macro parameters. Check macro definition
Poèet parametrù pøedávaných do makroinstrukce není shodný s poètem parametrù
uvedeným pøi definici makroinstrukce.

Directive �<direktiva>� is not supported
<direktiva> není pøekladaèem podporována.

Unimplemented register
Èíslo registru je mimo rozsah datové RAM.

Label is not allowed here
Na tomto øádku nelze definovat návì�tí.
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Missing symbol name
Chybí jméno symbolu.

Can not open macro file.
Soubor s definicemi makroinstrukcí nelze otevøít. Existuje?

Can not close macro file
Soubor s definicemi makroinstrukcí nelze uzavøít.

Duplicite macro definition �<makro>�
<makro> ji� bylo definováno. Zmìòte jméno makroinstrukce.

Number of macro parameters exceeds limit
Makroinstrukce mù�e mít maximálnì 10 parametrù. Zadáno jich je více.

Missing #endm directive
Neukonèená definice makroinstrukce.

Missing macro name
V definici makroinstrukce není zadáno jméno makroinstrukce.

Number of macro local labels exceeds limit
Pøekroèen poèet mo�ných lokálních návì�tí v makrech (max. 10).

Number of macros exceeds limit
Poèet makroinstrukcí pøekroèil zadaný limit.

Missing operand
V instrukci nebo direktivì chybí operand.

Invalid TRIS argument
�patný operand instrukce TRIS

Jump to different page of program memory
Skok programu na adresu mimo aktuální stránku programové pamìti.

This is a *DEMO* version
Je nainstalována demoverze pøekladaèe, která je omezena poètem pøekládaných
øádkù.

Too many errors & warnings
Zdrojový text programu obsahuje pøíli� mnoho chyb.

Unknown error
Neznámá chyba pøekladaèe.
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Poznámky:
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